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Introduction
This manual is intended to describe the characteristics, operation, calibration, and
maintenance of the AquaTROLL 600 Multiparameter Sonde.

Serial Number Location
The instrument serial number is on the product label affixed to the instrument body.
Serial numbers for individual sensors are engraved on the sensor body.

Instrument Description
The Aqua TROLL 600 Sonde is a multiparameter water quality sonde with LCD screen,
internal memory, and additional SD card storage. The Aqua TROLL 600 uses the latest
sensor and electronics technology to provide laboratory-quality measurements for field
use. The water level/pressure sensor and barometric pressure sensor are integrated
into the sonde. The optical Rugged Dissolved Oxygen (RDO®), conductivity,
temperature, turbidity, pH/ORP sensors and the RDO Sensor Cap are replaceable. It is
optional to include a motorized sensor wiper on the instrument.

The Aqua TROLL 600 can connect wirelessly via Bluetooth to the VuSitu Mobile App or
can connect to Win-Situ 5 Software using cable or Bluetooth.

Document Conventions
Throughout this document you will see the following symbols:

A check mark highlights a tip or feature.

The exclamation point calls your attention to a requirement, safety
issue, or important action that should not be overlooked.

Unpacking and Inspection
Your equipment was carefully inspected before shipping. Check the equipment for any
physical damage sustained during shipment. Notify In-Situ and file a claim with the
carrier if there is any such damage; do not attempt to deploy or operate the instrument.

Save packing materials for future storage and shipping of your
equipment.
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Accessories may be shipped separately and should also be inspected for physical
damage and fulfillment of your order.

Obtaining Repair Service
If you suspect your system is malfunctioning and repair is needed, you can help assure
efficient servicing by following these guidelines:

1. Call or email In-Situ Technical Support. Have the product model and serial number
available.

2. Be prepared to describe the problem, including how the product was used and the
conditions noted at the time of the malfunction.

3. If Technical Support determines that service is needed, they will ask your company
to fill out the RMA form and pre-approve a specified monetary amount for repair
charges. When the form and pre-approval is received, Technical Support will assign
an RMA (Return Material Authorization) number.

4. Clean the product as described in the manual.

5. If the product contains a removable battery, remove and retain it unless you are
returning the system for a refund or Technical Support states otherwise.

6. Carefully pack your product in its original shipping box, if possible.

7. Mark the RMA number clearly on the outside of the box.

8. Send the package, shipping prepaid, to:

In-Situ
ATTN: Repairs
221 East Lincoln Avenue
Fort Collins, CO 80524

The warranty does not cover damage during transit. In-Situ recommends insurance for
all shipments. Warranty repairs will be shipped back prepaid.

Outside the U.S.

Contact your international In-Situ distributor for repair and service information.

Guidelines for Cleaning Returned Equipment
Please help us protect the health and safety of our employees by cleaning and
decontaminating equipment that has been subjected to potential biological or health
hazards, and labeling such equipment. Unfortunately, we cannot service your
equipment without such notification. Please complete and sign the form on page 13 (or
a similar statement certifying that the equipment has been cleaned and
decontaminated) and send it to us with each instrument.



1-970-498-1500 12 www.in-situ.com

l We recommend the glassware cleaning product, Alconox, available from In-Situ
and from laboratory supply companies.

l Clean all cables and remove all foreign matter.

l Clean the cable connectors with a clean, dry cloth. Do not submerge the
connectors.

l Clean the instrument including the nosecone, cable head, and protective caps.

If an instrument is returned to our Service Center for repair or
recalibration without a statement that it has been cleaned and
decontaminated, or if it is the opinion of our Service
Representatives that the equipment presents a potential health or
biological hazard, we reserve the right to withhold service until
proper certification is obtained.
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Decontamination and Cleaning Form

Safety

l Use D-cell alkaline batteries.

l Do not use batteries of different ages or types.

l Do not submerge the Wireless TROLL Com or your mobile device in liquid.

l Ensure that sensors, or sensor plugs, are completely inserted into the ports, so
that no liquid can enter the instrument.

l Ensure that the RDO Sensor Cap is pressed firmly over the sensor lens and is
flush with the instrument before submerging in liquid.

l Replace the cable if insulation or connectors are damaged.

l Make sure the probe and sensor O-rings are clean and free of damage.
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General Specifications

Operating
temperature -5 to 50° C (23 to 122° F)

Storage temperature Components without fluid: -40 to 65° C (-40 to 149° F)
pH/ORP probes: -5 to 65° C

Dimensions
4.7 cm (1.85 in.) OD x 59.2 cm (23.3 in.) with restrictor
installed (including connector)
With bail: 72.9 cm (28.7 in.)

Weight 1.45 kg (3.2 lbs) - includes all sensors, batteries, bail

Wetted materials
(sonde and sensors)

Ceramic, Delrin™, Inconel™, PC, PC alloy, Platinum,
Nylon, Santoprene™,Titanium, Viton™

Environmental rating
IP68 with all sensors and cable attached. IP67 with
sensors removed, battery cover removed, or cable
detached

Max pressure rating Up to 350 PSI

Communication RS485/MODBUS, SDI-12, Bluetooth®

Reading rate 1 reading every 2 seconds for one parameter, no wipe

Internal memory1 16 MB

Additional memory,
micro SD card2 8 GB included, any size micro SD accepted

Logging rate 1 minute to 99 hours

Logging modes Linear, Linear Average, Event

Data logging 50 logs (defined, scheduled to run, or stored)

LCD screen Integrated display shows status of sonde, sensor
ports, data log, battery, and connectivity

Internal power
Battery life3

(2) user-replaceable D-cell alkaline batteries
>6 months typical with wiping
>9 months typical without wiping

External power
voltage4

External power
current4

8-36 VDC, 275 mA maximum (not required)

Sleep: 0.10 mA typical
Measurement: 15 mA typical, 45 mA maximum

Interface Win-Situ 5 Software, VuSitu Mobile App on select
mobile devices using Android 4.4 with Bluetooth 2.0
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Cable Vented or non-vented polyurethane or vented Tefzel®

Hex screw driver 0.050 in. (1.3 mm)

Software Interface

Android: VuSitu available on the Google Play Store
(Android 4.4 or above, requires Bluetooth 2.0)
Windows: Win-Situ 5
Data Services: HydroVu

Certifications CE, FCC, WEEE, RoHS compliant

Warranty

2 year - sonde, sensors (excluding pH/ORP);

1 year - pH/ORP sensor

Other - see warranty policy at www.in-situ.com

Notes

Specifications are subject to change without notice.
Android is a trademark of Google, Inc. Bluetooth is a
trademark of Bluetooth SIG, Inc. Delrin and Tefzel are
trademarks of E.I. du Pont de Nemours & Co.
Santoprene is a trademark of ExxonMobile. Inconel is
a trademark of Special Metals Corporation. Viton is a
registered trademark of DuPont Performance
Elastomers L.L.C.

1For 30 parameters>100,000 data records, > 3 years at 15 minute interval. A
single data record includes timestamp, temperature, RDO, pH, ORP, turbidity,
and conductivity logged in Linear or Linear Average mode.
2Log data recorded to SD card in comma delimited variable (CSV) file format.
3Logging all sensors at 15 minute interval on 2 D-cell alkaline batteries.
Battery life dependent on site conditions and wiping.
4Dependent on display and wiping
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Instrument Dimensions with Restrictor On

Total length with connector 59.16 cm (23.29 in.)

Diameter 47 mm (1.85 in.)

Instrument Dimensions with Restrictor Off

Total length with wiper brush on 55.14 cm (21.72 in.)

Total length with wiper brush off 51.53 cm (20.29 in.)

Diameter 41.66 mm (1.64 in.)

Sensor Specifications

Barometric Pressure Sensor Specifications

Accuracy ±1.0 mbar

Range 300 to 1,100 mbar

Resolution 0.1 mbar

Sensor Type Fixed

Response
Time T63<1s, T90<1s, T95<1s
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Units of
Measure psi, kPa, bar, mbar, mmHg, inHg

Methodology Silicon strain gauge

Conductivity Sensor Specifications

Accuracy* ±0.5% of reading plus 1 μS/cm from 0 to 100,000 μS/cm;
±1.0% of reading from 100,000 to 200,000 μS/cm

Range 0 to 350,000 μS/cm

Resolution 0.1 µS/cm

Sensor Type Removeable

Response
Time T63<1s, T90<3s, T95<5s

Units of
Measure

Actual conductivity: μS/cm, mS/cm
Specific conductivity: μS/cm, mS/cm
Salinity: PSU
Total dissolved solids: ppt, ppm
Resistivity: Ohms-cm
Density: g/cm3

Methodology Std. Methods 2510, EPA 120.1

*Accuracy at calibration points.

Total Dissolved Solids

TDS is derived from conductivity and temperature.

Range 0 to 350 ppt

Resolution 0.1 ppt

Units of
Measure ppt, ppm

Salinity

TDS is derived from conductivity and temperature.

Range 0 to 350 PSU

Resolution 0.1 PSU

Units of
Measure PSU

Methodology Std. Methods 2520A
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Dissolved Oxygen RDO Sensor Specifications

Accuracy
±0.1 mg/L from 0 to 8 mg/L
±0.2 mg/L from 8 to 20 mg/L
±10% of reading from 20 to 50 mg/L

Range

0 to 8 mg/L
8 to 20 mg/L
20 to 50 mg/L
Full operating range: 0 to 50 mg/L; 0 to 500% saturation

Resolution 0.01 mg/L

Sensor Type Removable with replaceable RDO-X Cap

Response
Time RDO-X Cap: T63<15s, T90<45s, T95<60s

Units of
Measure mg/L, % saturation, ppm

Methodology
EPA-approved In-Situ Methods (under the Alternate Test
Procedure process): 1002-8-2009, 1003-8-2009, 1004-8-
2009

Level, Depth, Pressure Sensor Specifications

Accuracy Typical ±0.1% full scale (FS)

Range

Non-vented or Vented
9.0 m (30 ft) - Burst: 27 m (90 ft)
30 m (100 ft) - Burst: 40 m (130 ft)
76 m (250 ft) - Burst: 107 m (350 ft)
200 m (650 ft) - Burst: 229 m (750 ft)

Resolution ±0.01% FS or better

Sensor Type Fixed

Response
Time T63<1s, T90<1s, T95<1s

Units of
Measure

Pressure: psi, kPa, bar, mbar, mmHg, inHg, cmH2O, inH2O
Level: mm, cm, m, in, ft, cmH2O, inH2O

Methodology Piezoresistive; ceramic

*Typical performance across full temperature and pressure calibrated range.
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ORP Sensor Specifications

Accuracy* ±5.0 mV @ 25° C

Range ±1,400 mV

Resolution 0.1 mV

Sensor Type Replaceable pH/ORP combo sensor

Response
Time** T63<3s, T90<15s, T95<30s

Units of
Measure mV

Methodology Std. Methods 2580

*Accuracy from standard at 25° C.
**At thermal equilibrium immediately following calibration, measuring from air
to +400 mV

pH Sensor Specifications

Accuracy ±0.1 pH units or better

Range 0 to 14 pH units

Resolution 0.01 pH unit

Sensor Type Replaceable pH/ORP combo sensor

Response
Time* T63<1s, T90<2s, T95<3s

Units of
Measure pH units

Methodology Std. Methods 4500-H+, EPA 150.2

*At thermal equilibrium.

Temperature Sensor Specifications

Accuracy ±0.1° C

Range -5 to 50° C (23 to 122° F)

Resolution 0.01° C

Sensor Type Replaceable

Response
Time T63<2s, T90<15s, T95<30s
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Units of
Measure ° C, ° F

Methodology EPA 170.1

Sensor only, when transferring from air to ambient water temperature. Typical
system response time with all sensors and restrictor installed: T63<30s;
T90<3.5m; T95,7.5m

Turbidity Sensor Specifications

Accuracy ±2% of reading or ±2 NTU or FNU, whichever is greater

Range 0 to 4,000 NTU

Resolution 0.01 NTU (0 to 1,000 NTU)
0.1 NTU (1,000 to 4,000 NTU)

Sensor Type Replaceable

Response
Time T63<1s, T90<1s, T95<1s

Units of
Measure NTU, FNU

Methodology ISO 7027

Total Suspended Solids

TSS is derived from turbidity.

Range 0 to 1,500 mg/L

Resolution 0.1 mg/L

Units of
Measure ppt, mg/L

User-defined reference.
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Instrument Overview

Synopsis
The Aqua TROLL® 600 is a portable, intelligent water quality data logging instrument
built to measure and store water level (pressure), temperature, barometric pressure, and
water quality data for many applications under many environmental conditions,
including marine waters. The instrument’s outside diameter (OD) allows the instrument
to conform to a 2-in./5.08 cm diameter (or larger) well. The Aqua TROLL 600 is
recommended for applications like ambient long-term water quality monitoring in fresh
and marine environments; groundwater quality sampling (e.g., low-flow groundwater
sampling, groundwater quality monitoring); mine water monitoring; stormwater
management; vertical profiling; horizontal transect; and other environmental
applications in normal and extreme environmental conditions. The housing and
sensing materials allow it to be used in various environments from fresh water to
saltwater. The instrument’s LCD screen provides clear, instant visual indicators of
overall readiness, battery life, internal log, sensor status, and connectivity. It is easily
programmed through the VuSitu™ Mobile Application available for Android™ devices
(Android 4.4, requires Bluetooth® 2.0) or Win-Situ® 5 for Windows®. Users can email
data from an Android device via the VuSitu Mobile App; log data to a smartphone; or
download data directly to a computer via smartphone connection; tag sites with GPS
coordinates; and keep track of sites with photos and descriptions. Data can also be
downloaded via an internal, removable micro SD card. Calibrations are simplified
through auto-detection of calibration solutions and auto-stabilization. The instrument
can be deployed using In-Situ’s RuggedCable System, and with In-Situ’s Tube/Cube
Telemetry Systems and HydroVu™ Data Services for real-time data access anywhere
there is an internet connection.
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System Components

Base Unit Components

Component Part Number
RDO Sensor - includes RDO-X Cap 0063450
Combination pH/ORP Sensor 0063470
Turbidity Sensor 0063480
Combination Conductivity/Temperature Sensor or
standalone Temperature Sensor 0063460, 0063490

8 GB Micro SD Card 0078950
Alkaline Batteries (2) 0042020
Dual Stainless Steel Restrictor/Storage Chamber 0079820
Calibration Cup 0079870
Sensor Port Plugs (2) 0063510
Rubber Bumpers (2) 0079880
Wiper or Wiper Port Plug 0063500, 0064630

Accessories purchased separately.

Communications
Wireless TROLL Com for Android 0031240
Mobile Device for Android 0064860
TROLL Com RS-232 Cable Connect 0056140
TROLL Com USB Cable Connect 0052500
TROLL Com RS-232 Direct Connect 0056150
TROLL Com USB Direct Connect 0052510

Cable
Stripped-and-tinned Cable with male connector 0053310
Twist-Lock Bulkhead Connector 0053240
Twist-Lock Backshell / Hanger, Titanium 0051480
Cable Extender 0051490
Large Desiccant (titanium connector) 0051810
Large Desiccant (ABS connector) 0053550
Small Desiccant (3 pack) - storage desiccant 0052230
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Cable
Stripped-and-tinned Cable with male connector 0053310
Twist-Lock Bulkhead Connector 0053240
Twist-Lock Backshell / Hanger, Titanium 0051480
Cable Extender 0051490
Large Desiccant (titanium connector) 0051810
Large Desiccant (ABS connector) 0053550
Desiccant Refill Kit for Large or Outboard Desiccant 0029140

Calibration and Maintenance
RDO Classic Cap Replacement Kit 0079790
pH/ORP Replacement Reference Junction Kit 0078990
Wiper Brush Kit 0079810
Maintenance Kit 0078940
Copper Antifouling Guard 0076100
Quick-Cal Solution for calibrating DO, Cond., pH & ORP 0033250
Dissolved Oxygen Calibration Kit 0032110
D.O. Field Calibration Kit 0080830
Conductivity Calibration Kit (Full) 0032090
Conductivity Calibration Kit (Low) 0032630
Conductivity Calibration Kit (High) 0032640
pH Calibration Kit 0032080
pH/ORP Calibration Kit 0032120
pH Storage Solution 0065370
Individual Calibration Solutions See website

Low-Flow
Complete Low-Flow Kit (includes flow cell with fittings
and stake, base plate, documentation) 0066820

Flow Cell Kit 0066830
Flow Cell Base Plate 0044430
Fittings Kit 0093480
Pelican Case with foam insert 0066860
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RuggedCable System
RuggedCable Systems are custom-built, durable, direct-read cables that include the
following items.

l Titanium twist-lock connectors for quick, reliable connections to the instrument,
desiccant, and communication cable

l Metal shield beneath the cable jacket to prevent electrical interferences

l Kellems grip for secure instrument deployment

l Small desiccant for vented systems (for storage only)

Non-vented cables are marked with VF, which means vent free.

Vented or Non-Vented Cable

Vented cable is used with vented pressure sensors to produce gauged measurements.
The cable vent tube ensures that atmospheric pressure is applied to the back of the
sensor diaphragm.

Non-vented cable is used with non-vented instruments for absolute measurements.
Compensate absolute measurements by using a BaroTROLL Instrument and Win-Situ
Baro Merge Software.

Vented cable is shipped with a small desiccant to protect against
condensation. Larger desiccants are necessary for deployment.

Jacket Options

Tefzel (vented) or thermoplastic polyurethane (TPU, vented or non-vented)

Customizable Cable Lengths

Cables can be ordered up to 1,219 m (4,000 ft).

Cable Termination

Cables can be ordered with a twist-lock termination (female connector) on both ends
that connect to the instrument, the TROLL Com Communication Device, desiccant, and
other accessories.

Cables can also be ordered with stripped-and-tinned termination for wiring to a data
logger or controller using SDI-12, analog (4-20 mA), or Modbus communication
protocol.
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1 RuggedCable System with female to female connectors
2 Stripped-and-tinned RuggedCable System with female connector

3
Stripped-and-tinned RuggedCable System with male connector
(short length that converts a cable with a twist-lock connector to a
stripped-and-tinned cable)
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Instrument Setup

Box Contents

1 Documentation and software

2 Wiper motor and brush or wiper port plug

3 Aqua TROLL® 600 Sonde

4 Water quality sensors (2 of 4)

5 Calibration cup

6 Water quality sensors (2 of 4)

7 RDO sensor cap

8 Accessory supplies*

9 pH/ORP sensor maintenance supplies

10 Extra sensors (0 to 2)
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11 D-cell alkaline batteries (2)

12 Instrument tools†

* Accessory supplies include wiper screws (2), wiper brush (2), silicone lubricant for O-
rings (2), battery compartment desiccant, replacement battery compartment hex screw
driver, lens cloth, and micro SD card adapter.

† Instrument tools include a 0.050 in./1.3 mm hex screwdriver for sensor screws, a
flathead screwdriver for the pH reference junction, and a Phillips head screwdriver for
bail screws.

Install the Batteries

1. Twist open the battery compartment, remove the disposable desiccant pack in the
battery compartment, and install the batteries.

1 Allen wrench (backup)
2 Replaceable desiccant
3 D-cell alkaline batteries
4 Micro SD card

Install two alkaline D-cell batteries.
Use only alkaline batteries. Do not use batteries of different ages.
For more information on batteries, see "Batteries" on page 37.

2. On the opposite side of the batteries is a back-up Allen wrench that can be used for
sensor installation and removal.

3. Check to see that the replaceable desiccant capsule is blue indicating it is fresh.
Replace the desiccant if it is pink.

4. Close the battery compartment. If the batteries are installed correctly the LCD
screen will turn on.
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Desiccant
The Aqua TROLL 600 contains a small, replaceable desiccant capsule in the battery
compartment. This capsule prevents moisture from causing damage to the electronic
components. It is filled with color-indicating silica that gradually changes from purple to
pink as the desiccant's effectiveness decreases. Replace the desiccant when the
desiccant has turned pink. The desiccant is included in the Aqua TROLL 600
Maintenance Kit (0078940).

Replace the Desiccant

1. Remove the battery cover.

2. Remove the backup wrench tool from the back of the battery compartment.

3. Insert the backup wrench into the small hole on the back side of the battery
compartment and push the desiccant capsule out.

4. Insert a new desiccant capsule and push the capsule in fully using the wrench.

Install the Wiper Motor and Sensors

1. Remove the restrictor.

2. Remove the protective sticker from the end of the sonde to expose the sensor ports.

Rubber bumpers are included on the ends of the sonde to help
prevent the sonde from rolling off working surfaces. You can
deploy the sonde with or without these safeguards.

3. Locate the cylindrical wiper motor (or motor port plug) and remove the dust cap.
Apply a small amount of lubricant from the maintenance supplies to the O-rings.
Align the pins and push the motor (or plug) firmly into the center port.

Notice the blue sensor interlock grooves on the wiper motor. You
must install the sensors so that they slide into the grooves.
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1 Sensor interlock grooves
2 Sensor interlock tab

Salt crystals may form on pH/ORP sensors during storage. These
crystals are normal and do not impact sensor performance.

When installing an RDO sensor, install the RDO Cap before
installing the sensor body on to the sonde. Make sure the RDO
cap is seated firmly inside the sensor housing.

4. Locate the conductivity sensor. Remove the dust cap and apply lubricant to the
conductivity sensor O-rings. Install the sensor into port 1 making sure the sensor
tongue slides into the blue motor interlock groove.
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Sensors can be installed in any port, however, installing the
conductivity sensor in port 1 allows for the most efficient energy
consumption.

5. Install the remaining sensors, applying lube to all O-rings. Sensors should be
seated tightly together with no gaps between connecting edges or the instrument
base.

6. When all sensors are installed, use the Allen wrench to tighten the screw at the
base of each sensor. Do not overtighten the screws.

7. Place the metal restrictor over the sensors and twist into place. Ensure that the vent
holes are located at the base of the instrument to allow sufficient flow to the sensors.

Note: The restrictor can be inverted to act as a storage cup when
the instrument is not in use. See "Instrument Storage" on page
111.

Removing Sensors

1. Loosen the sensor screw.

2. Insert the Allen wrench into the small hole at the base of the sensor.

3. Push the wrench body towards the sensor so the inserted tip of the wrench rotates
towards the sonde body.
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4. Pull the sensor out of the port.

Connecting to the Sonde

Connecting RuggedCable

Connect the Instrument to the RuggedCable

1. Remove the protective caps from the instrument and cable. Ensure that the O-ring
on the instrument connector is clean.

2. Position the instrument and cable flat edges so they will connect properly. Insert the
instrument connector firmly into the cable connector.

3. Hold the textured section of the sleeve in one hand and the instrument in the other.
Push and twist until you hear a click. The click ensures the cable and instrument are
securely attached.

Connect TROLL Com Communication Device to the RuggedCable System

1. If a desiccant is present, remove the desiccant from the cable. Twist the desiccant
and cable sleeve in opposite directions to unlock the desiccant from the cable.

2. Position the TROLL Com and cable flat edges so they will connect properly. Push
and twist until you hear a click.
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Connecting with Bluetooth
The Aqua TROLL 600 can connect to a Bluetooth-enabled device for wireless
communication with the VuSitu Mobile App or Win-Situ 5.

1. Turn on the Aqua TROLL 600 LCD screen by holding the sonde vertical with the
sensor end facing up.

2. On the Bluetooth-enabled device, navigate to the Bluetooth menu and scan for
available devices.

3. The Aqua TROLL 600 will be listed as "Serial Number - AT600". For example,
424690 - AT600. Tap the device name to pair the Aqua TROLL 600 and the
Bluetooth-enabled device.

Connecting to VuSitu

1. Open the VuSitu Mobile App. If you have correctly paired your Aqua TROLL 600
with your wireless device, and the instrument is available, the software will connect
and display readings.

If the Searching screen continues to show, tap Choose another
device and select the device you are trying to connect to.

Connecting to Win-Situ 5

1. Open Win-Situ 5 Software.

2. When prompted, "Connect to device now?" click No.

3. Click Preferences, then click Comm Settings.

4. Select the correct Com port used by Bluetooth, then select the following settings:

l Baud: 19200

l Data Bits: 8

l Parity Bits: None

l Stop Bits: 1

l Device Address: 1

l Mode: Modbus-ASCII

5. Click the checkmark, then click the Connect button in the lower right hand corner.

Connecting to a Wireless TROLL Com
A Wireless TROLL Com can be used to connect the instrument to software if the sonde
is deployed on a cable.
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1. Turn on the Wireless TROLL Com.

2. Make sure the cable is connected to the instrument as well as the communication
device.

3. Go to Bluetooth settings on your mobile device or computer.

4. From the Bluetooth section, search for devices.

5. Tap or click the serial number of the communication device to pair the device with
the phone or computer. The serial number is located under the USB flap.

Connecting to VuSitu

1. Open the VuSitu Mobile App. If you have correctly paired your Wireless TROLL
Com with your wireless device, and the instrument is available, the software will
connect and display readings.

If the Searching screen continues to show, tap Choose another
device and select the device you are trying to connect to.

Connecting to Win-Situ 5

1. Open Win-Situ 5 Software.

2. When prompted, "Connect to device now?" click No.

3. Click Preferences, then click Comm Settings.

4. Select the correct Com port used by Bluetooth, then select the following settings:

l Baud: 19200

l Data Bits: 8

l Parity Bits: None

l Stop Bits: 1

l Device Address: 2

l Mode: Modbus-ASCII

5. Click the checkmark, then click the Connect button in the lower right hand corner.

LCD Screen

LCD Screen
The AquaTROLL 600 includes an LCD screen that allows you to view instrument status
and access sonde settings.
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Turn on the LCD Screen

1. Hold the sonde vertically so the sensor end faces up.

2. The LCD screen will illuminate after a few seconds briefly displaying the platform
name and firmware version, followed by the RDO Sensor Cap expiration
information (if applicable).

3. The LCD screen will then display port status, power status, log status, and
connection status (when applicable).

Below is one example of how the LCD screen will appear when the instrument is ready
to be deployed.

1 Port Status

2 Power Status

3 Log Status

4 Connected Status
(shown only when connected)

Status Icons

Possible Port
Status

Possible Power
Status

Sensors are installed Battery level indicator

Sensor Port Plugs are installed External power provided

Sensor error Battery error or
Battery below 10%

Ports are open

Possible Log
Status

Possible Connected
Status

A log is running Connected to software
via Bluetooth
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Possible Port
Status

Possible Power
Status

A log is scheduled Connected to software
via cable

A log is paused

No log is configured

Additional LCD Icons

Instrument is working on a task.

Three taps on the instrument body allows access to the menu.
A single tap selects the highlighted menu item.

Tilt the instrument to the left to scroll up through the menu items.

Tilt the instrument to the right to scroll down through the menu items.

Indicates the top of the menu has been reached.

Indicates the bottom of the menu has been reached.

Consult the manual.

Full-Text Messages

The LCD will display text messages instead of status icons when certain conditions are
met. Multiple messages will rotate and display for 3 seconds each.

Text Message Cause and Remedy

Close battery cover Battery cover is not fully closed.
Ensure the battery cover is securely tightened.

Install wiper Wiper sensor port is open.
Install wiper or wiper port plug into center port.

Install sensors Sensor ports are open.
Install sensors or sensor port plugs.

Install temperature No Temperature or Conductivity/Temperature sensor detected.
Install a sensor with Temperature.
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Text Message Cause and Remedy

Install RDO Cap RDO Cap not detected on RDO sensor.
Install RDO cap.

RDO Cap expired RDO cap is no longer valid.
Install a new RDO Cap.

RDO Cap XXX days Temporary text message update on the lifespan of the RDO Cap.

Sonde Menus
Sonde settings are accessed from menus displayed on the LCD screen. Within the
sonde menus you can start or stop a simple data log, change the contrast or language
settings, and update firmware for the sonde or sensors.

Accessing the Sonde Menus

1. Hold the sonde vertically so the sensor end faces up. The LCD screen will
illuminate after a few seconds.

2. Wait until the LCD screen displays the status icons.

3. Hold the sonde horizontally and firmly tap the Aqua TROLL 600 Logo next to the
LCD screen 3 times, pausing 1 second between taps.

4. The LCD screen will display the Main Menu along with arrow icons.

5. Tilt the sonde right or left to scroll through menu options.

6. To select a menu option, ensure it is highlighted with a black background and light
text and firmly tap the Aqua TROLL 600 logo once.

Data Log Menu

The Data Log menu allows you to create and start a basic linear data log (if none has
been set in Win-Situ 5 or VuSitu Software), or stop a log if it is running.

Start a Log

1. Access the data log menu.

2. Select New.

3. Select the desired reading interval. The data log will start once the interval is
selected.

The data log will appear in Win-Situ with the Log Name "Aqua TROLL 600 SERIAL
NUMBER," where SERIAL NUMBER will be the serial number of the unit. This log
records all sensors and parameters and is a no wrap log. This means once the data
capacity is reached the log will stop.
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You are unable to update the instrument firmware while a log is
running. Stop a log to update the sonde or sensors.

Stop a Log

1. Access the Data Log menu.

2. Select Stop.

3. Select Yes. The data log will stop.

Contrast Menu

The Contrast Menu allows you to adjust the contrast on the LCD screen.

1. Access the Contrast menu.

2. Tilt the sonde left to decrease (lighten) the contrast, or right to increase (darken) the
contrast.

3. Tap the Aqua TROLL 600 logo to set the selected contrast.

Language Menu

The Language Menu allows you to set the default display language of the LCD screen.

1. Access the Language menu.

2. Highlight the desired language (English, Spanish, French, German).

3. Tap the Aqua TROLL 600 logo to set the selected language.

Updates Menu

The Updates Menu allows you to update firmware for the sonde or installed sensors.

1. Access the Updates menu.

2. Highlight the desired component to update (Sonde, Sensor 1 to 4).

If an update is present on the SD card, the screen will indicate the
previous firmware version, a right-facing arrow, and the new
version of the firmware.

3. Select Yes to update the firmware.

For more information on firmware updates, see "Updating Firmware" on page 39.

Batteries
The Aqua TROLL 600 uses two standard D-cell 1.5 V alkaline batteries.
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Battery Replacement

1. Open the battery compartment and remove both batteries.

2. Insert new batteries. Ensure the LCD screen turns on.

3. Replace the battery cover.

Never use lithium batteries, or batteries that are different ages or
manufacturers.

In-Situ recommends using new batteries every time.

Micro SD Card
The Aqua TROLL 600 uses a micro SD card for data storage and updating sonde
firmware. You can remove the SD card and replace it with another for data download, or
use the same card. An SD card is not required to log data.

Removing the Micro SD Card
The micro SD card is housed in a slot near the positive battery terminal and the twist-
lock connector.

1. Remove the battery cover from the end of the instrument.

2. Push the micro SD card in towards the instrument to release the card.

3. Remove the card from the slot.

4. To reinstall the card, note the card position diagram in the finger slot. Push the card
into the slot until you hear a click.

Downloading and Deleting Data from the Micro SD Card

1. Remove card from the sonde and insert it into a micro SD card adapter.

2. Insert the adapter into a PC or laptop.

3. Open the micro SD card using the file explorer.

4. Open the folder titled "Serial Number.LOG." For example, "424690.LOG."

Logs are named by date and then number. For example, a log
started on November 12, 2015 would be named "15111200.CSV"
- 15 is the year, 11 is the month, 12 is the day, and 00 is the log
number. If multiple logs are recorded on the same day the last
number will increase by one for each consecutive log.

5. Select the logs you wish to download and move them to the destination.
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6. Select the logs you wish to delete and press Delete on the keyboard. Deleted logs
cannot be recovered.

Updating Firmware

1. Download the firmware update files to your computer.

2. Remove the SD card from the unit and insert it into your computer.

You may need a micro SD card adapter to connect the SD card to
your computer. One is included with your Aqua TROLL 600, but
any micro SD card adapter can be used.

3. Copy the firmware update files into the ISI.FW file on the SD card.

4. Install the SD card into the instrument and install the battery cover.

5. Turn on the LCD screen by inverting the sonde so the sensor end faces up.

6. Access the instrument menu by tapping the Aqua TROLL 600 logo on the yellow
label three times. For more information on accessing menus, see "LCD Screen" on
page 33.

7. Scroll to Updates by tilting the instrument. Access the Updates menu by tapping the
Aqua TROLL 600 logo once.

8. Scroll to Sonde by tilting the instrument. Tap the Aqua TROLL 600 logo once.

9. The LCD screen will display the current firmware version on the left, then an arrow,
and the new firmware version on the right.

10. Scroll to Yes by tilting the instrument. Tap the Aqua TROLL 600 logo once.

11. The LCD screen will display icons while updating. Once the update is complete the
Aqua TROLL 600 and LCD screen will restart.

Desiccant
The Aqua TROLL 600 contains a small, replaceable desiccant capsule in the battery
compartment. This capsule prevents moisture from causing damage to the electronic
components. It is filled with color-indicating silica that gradually changes from purple to
pink as the desiccant's effectiveness decreases. Replace the desiccant when the
desiccant has turned pink. The desiccant is included in the Aqua TROLL 600
Maintenance Kit (0078940).

Replace the Desiccant

1. Remove the battery cover.

2. Remove the backup wrench tool from the back of the battery compartment.
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3. Insert the backup wrench into the small hole on the back side of the battery
compartment and push the desiccant capsule out.

4. Insert a new desiccant capsule and push the capsule in fully using the wrench.

Sensor Calibration

Preparing the Aqua TROLL 600 for Calibration

1. Remove the rubber bumper and blue top cap from the restrictor.

2. Remove the rubber gasket from the calibration cup and slide it on to the middle of
the restrictor.

3. Screw the cal cup on the bottom of the restrictor.

4. Pour the calibration solution into the cal cup.

5. Fully seat the rubber gasket on the top of the cal cup.

6. Gently tap the cup and sonde at an angle to remove all bubbles from the sensor
faces.

Always remove bubbles from sensor faces to improve calibration
accuracy.

7. If performing an RDO calibration, ensure the gasket notch is lined up with the vent
hole of the cal cup.

Sensor calibration procedures vary based on the software you are using to program
the instrument. If you are using the VuSitu Mobile App, see "About Calibration and
Settings" on page 52. If you are using Win-Situ 5 Software, see "Calibrate Sensors"
on page 82.

Calibration Recommendations
In-Situ sensors are factory calibrated across the entire range of each sensor, and thus
achieve a very high degree of accuracy and stability for extended periods of time
without user calibration. In-Situ recommends inserting the instrument into a known
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calibration standard to check the accuracy of a sensor prior to performing any user
calibration if you suspect drift, unless a user calibration is required by a standard
operating procedure.

Sensor Recommended User
Calibration Frequency

Recommended
Factory
Calibration
Frequency

Notes

Conductivity Only when required by user
protocol 12 months K-cell value: 0.7 to 1.3

Conductivity +
Temperature

Only when required by user
protocol 12 months K-cell value: 0.7 to 1.3

pH
10 to 12 weeks or as
required by user protocol or
site conditions

12 months

Single point:
Theoretical mV ±30 mV
2- or 3-point Slope:
-66 to 50 mV/pH
2- or 3-point Offset:
350 to 450 mV

ORP
10 to 12 weeks or as
required by user protocol or
site conditions

12 months Offset: ±30 mV

RDO 12 months or as required by
user protocol 12 months

2-point Slope:
0.7 to 1.3
2-point Offset:
±0.3 mg/L

Temperature Only when required by user
protocol

Only when
required by user
protocol

Offset: ±0.5

Turbidity Only when required by user
protocol 12 months Slope: 0.7 to 1.3

Pressure/Depth Only when required by user
protocol

Only when
required by user
protocol

<2 times the full scale
accuracy specification

Barometer Only when required by user
protocol

Only when
required by user
protocol

<2 times the full scale
accuracy specification

Factory Calibration
Factory calibration of In-Situ instruments should be performed every 12 months, or
when the unit data appears to drift significantly. Factory calibration includes a thorough
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cleaning, full functionality check, and sensor adjustments to all applicable sensors over
the entire calibrated temperature range.

Software
The Aqua TROLL 600 can be programmed using the VuSitu Mobile App for Android, or
using Win-Situ 5 Software.

VuSitu Mobile App

Verify the VuSitu Mobile App Version
To avoid potential compatibility issues, it is important to use the most recent version of
the VuSitu Mobile App. Find version information and app updates from the Google Play
Store.

Connecting with Bluetooth
The Aqua TROLL 600 can connect to a Bluetooth-enabled device for wireless
communication with the VuSitu Mobile App or Win-Situ 5.

1. Turn on the Aqua TROLL 600 LCD screen by holding the sonde vertical with the
sensor end facing up.

2. On the Bluetooth-enabled device, navigate to the Bluetooth menu and scan for
available devices.

3. The Aqua TROLL 600 will be listed as "Serial Number - AT600". For example,
424690 - AT600. Tap the device name to pair the Aqua TROLL 600 and the
Bluetooth-enabled device.

Connecting to VuSitu

1. Open the VuSitu Mobile App. If you have correctly paired your Aqua TROLL 600
with your wireless device, and the instrument is available, the software will connect
and display readings.

If the Searching screen continues to show, tap Choose another
device and select the device you are trying to connect to.

Connecting to Win-Situ 5

1. Open Win-Situ 5 Software.

2. When prompted, "Connect to device now?" click No.

3. Click Preferences, then click Comm Settings.
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4. Select the correct Com port used by Bluetooth, then select the following settings:

l Baud: 19200

l Data Bits: 8

l Parity Bits: None

l Stop Bits: 1

l Device Address: 1

l Mode: Modbus-ASCII

5. Click the checkmark, then click the Connect button in the lower right hand corner.
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VuSitu Overview

About VuSitu

The VuSitu Mobile App is the user interface and control application for In-Situ water
quality instruments. You can use VuSitu on mobile devices that use Android operating
system 4.4, Bluetooth 2.0, and newer.

VuSitu allows you to accomplish the following tasks.

l View live readings that update every 10 seconds.

l Change parameters and units.

l Record data.

l Email data in spreadsheet format.

l Download data to mobile device.

l Transfer data from mobile device to a computer.

l Organize data by Location.

l Calibrate Sensors and View Reports

VuSitu Menu Options

The features available in the VuSitu Mobile App vary slightly depending on the
instrument with which it is connected. Tap the menu icon in the upper left portion of the
screen to view the features included in VuSitu. Tap the menu icon again to close the
menu.

Menu Options when Connected to Instrument

Some features, such as sensor calibration, are not available when you are not
connected to an instrument.
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Live Readings Screen

The live readings screen displays instrument readings when the app is connected
to the communication device and/or to the instrument via Bluetooth.

1 Main Menu

2
Selected Location

(Tap to change Location.)

3

Live Readings (scrollable)

Tap the settings wheel next to
each to change parameters and
units.

4
Tap to record readings

(Readings refresh every 10
seconds.)

Changing Parameters and Units

1. From the Live Readings screen, tap the settings wheel next to the field that contains
the measurement value. When you release, the Parameter and Unit menu appears.
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2. Tap the parameter drop-down arrow and tap the parameter you want to display.

3. Tap the units drop-down arrow and tap the unit you want to display.

4. Tap the OK button to set the options and return to the Live Readings screen.

Record Data

1. From the Live Readings screen, tap Start Recording. A new set of readings is
updated every 10 seconds and a counter of readings is displayed in the Stop button.

2. It is optional to mark a set of readings by tapping the Mark button.

3. When you have gathered enough data, tap the Stop button.

4. The recorded data appears on screen. If you have marked data it will appear as a
highlighted row.
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5. If you want to return to the Live Readings screen, tap the Close button. (Your data
can be accessed later in the Data section of the app.)

6. If you want to send your data, tap the Send To... button.

l Select the VuSitu Folder to later download your data to a computer via USB
connection.

or

l Select your email application to email the data.

VuSitu Locations

About VuSitu Locations

A Location represents the physical location at which an instrument collects data. For
example, you can create a Location to represent a lake, gauging station, well, tank,
number, or nearby landmark. If you do not set up a Location, your data will be
associated with Default Location. The Location name is displayed on the Live
Readings screen. You can access Locations through the Main Menu or by tapping the
Location displayed in the lower portion of the Live Readings screen.
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Create a New Location

1. You can create a new Location with which to associate your data by selecting
Locations from the main menu, or by tapping the location shown on the Live
Readings screen.

2. Tap Add New Location.

3. Enter a name for the Location.

4. It is optional to add a photo to the Location. Tap the camera icon, take a photo and
select the check mark to select the photo.

5. It is optional to add notes to the Location. Tap the Notes field to enter additional
information about the Location.

6. It is optional to associate latitude and longitude coordinates with the Location. Tap
the map to activate the mapping feature.

7. Tap the GPS icon in the upper-right portion of the screen to navigate to your
current physical location.

8. Tap the Location icon to select the point on the map as the Location.

9. To manually set a Location, tap and hold to drop a pin on a specific area of the map.
This associates latitude and longitude with your Location.

As an alternative, you can manually enter latitude and longitude
values and tap Apply.

10. Tap Save.
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Select a Location

Data is associated with the Location that is displayed on the Live readings screen.

After you have created a Location, you must select it in order for your data to be
associated with the Location.

1. To Select a Location, tap the current Location displayed on the Live Readings
screen. The list of Locations appears.

2. The active Location is marked with a green check mark. If no Location has been
selected data will be associated with the Default Location.

3. Tap the desired location in the list.
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4. The Live Readings screen appears with the site selected.

Edit or Delete a Location

1. From the Main Menu, tap Locations.

2. Tap the Location you want to edit.

3. Tap the Overflow Menu in the upper-right portion of the screen.

4. Select Edit Location to make changes, or Archive Location to remove it from the list.

Archived Locations can be restored at any time by tapping the
Location, accessing the Overflow Menu and tapping Restore
Location.
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VuSitu Data

About Data

Recorded data from the Live Readings screen is stored in the VuSitu Data section of
the app. Data is organized by the Location that was active when the data was recorded.
You can view data on the device, delete the data, send the data through email, or save
the data to the VuSitu Folder so that it can be downloaded to your computer via USB
connection.

View, Send, Delete Data

1. From the Main Menu, select Data.

It is optional to filter results by Location. Tap the drop-down list
and select a Location.

2. Tap the desired data.
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l Tap Delete to remove the data from the data list.

l Tap View to see the data on the mobile device.

l Tap Send CSV to send an Excel-compatible file to email or the VuSitu Folder.
(When you send the report to the VuSitu Folder, you can later download the data
to a computer via USB cable.)

VuSitu Calibration & Settings

About Calibration and Settings

You can perform sensor calibrations, view a calibration report, or restore factory
calibration defaults when the instrument is connected to VuSitu.

1. Tap the VuSitu menu icon, and select Calibration & Settings from the list.

2. The available calibrations and sensor settings appear.

3. Tap the calibration you want to perform.

You can also access the full Calibration Report and Restore
Calibration Defaults from this menu.

Quick-Cal Multiple Sensor Calibration

Quick-Cal allows you to perform a one-point calibration on up to three sensors with one
setup and stabilization process.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibration Menu, select Quick-Cal (multi-sensor).
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4. All of the sensors available for the Quick-Cal calibration are selected by default. Tap
the checked box if you want to exclude a sensor from the calibration.

5. Select Next.

If one or more sensors is not installed, an error message will pop
up.

6. Make sure the vent is open on the cal cup.
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7. Fill the cup to the fill line with Quick-Cal standard. Place the instrument in the
calibration cup and select Next.

8. After the calibration is stable, select Accept.

9. The calibration values are applied to the sensor and appear on screen. You can
view a full calibration report for all sensors, or select Done to return to the
Calibration Menu.

10. Rinse the sensors and restrictor with DI water.

Calibrate the Rugged Dissolved Oxygen Sensor (1-Point)

The optical Rugged Dissolved Oxygen sensor is very stable. The factory calibration
should produce readings within 3% accuracy. If you require readings with greater
accuracy we recommend that you perform a 1-point, 100% water-saturated air
calibration as described below.

100%Water-saturated Air Calibration

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select RDO Saturation.

4. For a 1-point calibration, select 100% Saturation.

5. Make sure the vent is open on the cal cup.
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6. Place a small amount of clean water in the bottom of the cup.

7. Agitate the water by shaking the cup slightly from side to side.

8. Screw the Aqua TROLL 600 on to the cal cup and wait for 5 minutes.

9. Tap Next in the app to start the calibration.

10. After the calibration is stable, select Accept.

11. The calibration values are applied to the sensor and appear on screen. You can
view a full calibration report for all sensors, or select Done to return to the
Calibration Menu.

Calibrate the Rugged Dissolved Oxygen Sensor (2-Point)

We recommend that you perform the 0 % oxygen calibration only if you intend to
measure dissolved oxygen at a concentration of less than 4 mg/L.

100%Water-saturated Air Calibration

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select RDO Saturation.

4. For a 1-point calibration, select 100% Saturation.

5. Make sure the vent is open on the cal cup.
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6. Place a small amount of clean water in the bottom of the cup.

7. Agitate the water by shaking the cup slightly from side to side.

8. Screw the Aqua TROLL 600 on to the cal cup and wait for 5 minutes.

9. Tap Next in the app to start the calibration.

10. After the calibration is stable, select Accept.

11. After the calibration is stable, a prompt to prepare for the next calibration point
appears.

0-point Calibration

1. Fill the calibration cup to the fill line with sodium sulfite. Place the instrument in the
calibration cup.

2. Select Next.

3. After the calibration is stable, select Accept.

4. The calibration values are applied to the sensor and appear on screen. You can
view a full calibration report for all sensors, or select Done to return to the
Calibration Menu.

5. Rinse the sensors and restrictor with DI water.

Calibrating the Rugged Dissolved Oxygen Sensor Using Concentration

The preferred method of calibrating the RDO sensor is using the 1-point 100%
Saturation calibration. However, you can also calibrate the sensor using a
concentration method.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. Tap RDO Concentration.

4. Place the instrument in reference solution and tap Next.

5. Enter the value of the reference solution.
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6. After the calibration is stable, select Accept.

7. The calibration values are applied to the sensor and appear on screen. You can
view a full calibration report for all sensors, or select Done to return to the
Calibration Menu.

RDO Salinity Setting

The SmarTROLL RDO does not include automatic salinity compensation, so you must
set it manually.

1. From the main menu, select Connected Instrument.

2. Select Instrument Settings.

3. From the Instrument Settings menu select Salinity Setting.

4. Select the appropriate setting for your sampling environment.
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Calibrate the Conductivity Sensor

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibration Menu, select Conductivity.

4. Make sure the vent is open on the cal cup.

5. Fill the cup to the fill line with calibration standard. Place the instrument in the
calibration cup and select Next.

6. The app attempts to automatically detect the calibration solution and stabilize the
measurements.
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7. Check your bottle of calibration standard to determine the reference temperature. If
necessary, tap the drop down list and select the appropriate reference temperature
for the calibration.

If you are using a custom standard, the app will not automatically
detect it. Instead, a field will appear in which you can enter the
appropriate value. Select Set User Defined to begin calibrating
with the new value. If you are not using a custom standard and the
app does not automatically detect the standard, perform the
sensor cleaning and maintenance procedure, then select Retry
Auto Detect.

8. After the calibration is stable, select Accept.
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9. The calibration values are applied to the sensor and appear on screen. You can
view a full calibration report for all sensors, or select Done to return to the
Calibration Menu.

10. Rinse the sensors and restrictor with DI water.

Calibrate the Level Sensor

The factory calibration of the level sensor is very accurate. In-Situ does not recommend
calibrating the Level sensor unless your SOP specifically requires you to do so.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select Level.

4. Make sure that the pressure sensor is open to air and not submersed in water.

5. Select Next.

6. After the calibration is stable, select Accept.

Calibrate the pH Sensor

You can calibrate the pH sensor with either a 1-point, 2-point, or 3-point process.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select pH.
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4. Select a 1-, 2-, or 3-point calibration.

5. Make sure the vent is open on the cal cup.

6. Fill the calibration cup to the fill line with calibration standard. Place the instrument
in the calibration cup and select Next.

7. The app attempts to automatically detect the calibration solution and stabilize the
measurements.

8. If you are using a custom standard, the app will not automatically detect it. Instead, a
field will appear in which you can enter the appropriate value. Select Set User
Defined to begin calibrating with the new value. If you are not using a custom
standard and the app does not automatically detect the standard, perform the sensor
cleaning and maintenance procedure, then select Retry Auto Detect.

9. After the calibration is stable, select Accept.

Calibrate the ORP Sensor

The ORP sensor can be calibrated using Zobell's standard, Quick-Cal or a custom
ORP solution.
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1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select ORP.

4. Make sure the vent is open on the cal cup.

5. Fill the calibration cup to the fill line with calibration standard. Place the instrument
in the calibration cup and select Next.

6. The app attempts to automatically detect the calibration solution and stabilize the
measurements.

If you are using a custom standard, the app will not automatically
detect it. Instead, a field will appear in which you can enter the
appropriate value. Select Set User Defined to begin calibrating
with the new value. If you are not using a custom standard and the
app does not automatically detect the standard, perform the
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sensor cleaning and maintenance procedure, then select Retry
Auto Detect.

7. After the calibration is stable, select Accept.

8. The calibration values are applied to the sensor and appear on screen. You can
view a full calibration report for all sensors, or select Done to return to the
Calibration Menu.

9. Rinse the sensors and restrictor with DI water.

Calibrate the Turbidity Sensor

You can calibrate the Turbidity sensor with either a 1-point, 2-point, or 3-point process.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select Turbidity.

4. Select a 1- or 2-point calibration.
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5. Make sure the vent is open on the cal cup.

6. Fill the calibration cup to the fill line with calibration standard. Place the instrument
in the calibration cup and select Next.

7. The app attempts to automatically detect the calibration solution and stabilize the
measurements.

8. If you are using a custom standard, the app will not automatically detect it. Instead, a
field will appear in which you can enter the appropriate value. Select Set User
Defined to begin calibrating with the new value. If you are not using a custom
standard and the app does not automatically detect the standard, perform the sensor
cleaning and maintenance procedure, then select Retry Auto Detect.

9. After the calibration is stable, select Accept.

Win-Situ 5

Verify the Win-Situ Software Version

To avoid potential compatibility issues, it is important to use the
most recent version of Win-Situ Software. Find version
information and the most recent software download on the In-Situ
websitewww.in-situ.com.

Win-Situ 5 Screens and Buttons

Data Tab

When you open Win-Situ 5 Software, the Data tab appears. The left side of the screen
contains a file tree where you can view previously downloaded site data as well as data
you have exported to Microsoft Office Excel. The links on the right side of the screen
show where downloaded data are stored on your computer. The disconnected plug
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icon in the lower-right corner of the screen indicates that the software is not yet
communicating with an instrument.

Screen Element Definition

The disconnected plug indicates the instrument is not
communicating with the software. Click to establish communication
with a connected instrument.

The connected plug indicates the instrument is communicating
with the software. Click to disconnect the software from the
instrument.

The Home tab displays real-time readings from the instrument.
When connection to the instrument is first established, the software
displays one reading of all available parameters in light gray.
You must click the Play button at the bottom of the screen
to view real-time readings.

The Logging tab displays a list of logs stored in the connected
instrument. When you click the Logging tab, it can take a moment
for the software to retrieve information from the instrument. (Not
applicable for the RDO PRO-X and the Aqua TROLL 400.)
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Screen Element Definition

The Sensors tab lists the sensors in the connected instrument,
along with their serial numbers and the dates of factory calibration
and user calibration. Use the buttons in this tab to calibrate sensors
that support user calibration and configure sensors that are
supported by the instrument.

The Device Setup tab allows access to instrument information and
settings such as instrument name, serial number, firmware version,
communication settings, diagnostics, and factory reset options.

Home Tab

The Home tab displays real-time readings from a connected instrument. When you first
establish communication, the software displays one reading of all available parameters
in light gray. You must click the Start button to view real-time readings.

Screen Element Definition

The Sites button allows you to add, edit, or delete a site. Click the
drop-down arrow next to the button to view the list of sites.

The Device Memory gauge turns yellow when the internal memory
is used. Note: Non-logging instruments do not have internal
memory, however, the gauge shows 100 percent green when power
is applied.
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Screen Element Definition

The Device Battery gauge turns yellow as the battery is depleted.
This example shows 80 percent of the battery remaining (green) and
20 percent used (yellow). Note: Non-logging instruments do not
have internal batteries, however, the gauge shows 100 percent
green when power is applied.

The Logging Status icon:

Green—The instrument is actively logging data.

Gray—The instrument has no logs pending or running. Non-
logging instruments always show a gray status icon.

Yellow—The instrument has log data that was collected
according to specific instructions in the "Pending" or
"Suspended" state.

The Alarm icon provides additional instrument status
information.

Green—No alarms or warnings

Yellow—One or more warnings

Red—One or more alarms

Move the cursor over the alarm icon to view a description.
Click the Device Setup tab for detailed information on the
alarm or warning.

Note: Disregard the Device Reset alarm for non-logging
instruments such as the RDO PRO Probe or the Aqua TROLL
400.

System Time is displayed on the left. Device Time is displayed on
the right. Clocks are updated once every two seconds. When the
Device Time is displayed in red, it differs from the current System
Time, and should be synchronized.

The Time Sync button is used to write the current PC time to the
instrument. If you need to set the instrument clock to a time other
than the system (PC) time, use the Set Clock button on the Device
Setup tab.

Meter View shows the last known parameter values, displayed with
current units and time stamp. Readings are sized to occupy the
entire screen. This is the default display in the Home tab. If the type
is black, the readings are updating in real time.

List View is a running list of the most recent records. New readings
are continuously added to the top of the list and old readings scroll
off the bottom.
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Screen Element Definition

Graph View shows a real-time trend graph of the selected
parameters.

The Snapshot button records one set of readings.

The Record button logs data to a CSV file that can be opened in a
spreadsheet program. This is not the same as recording data in a
log on the instrument.

The Start/Stop button starts the display of real-time readings. The
typeface darkens, and readings are continuously updated until you
click the button again to stop. Several actions cannot be performed
while the Start button is active (for example, you cannot change
units, configure a new log, or configure level for a pressure sensor).
This is not the same as starting a log on the instrument. Start and
stop instrument logs from the Logging tab.

Logging Tab

The Logging tab displays a list of logs in the instrument. When you click the Logging
tab, it may take a moment for the software to retrieve information from the instrument.

Log Information

Columns across the Logging screen show information about the logs in the instrument.



1-970-498-1500 70 www.in-situ.com

l Symbol—This is a graphic representation of the information in the Status column.

l Site—The site that was specified when the log was configured.

l Log Name—The name that was entered when the log was configured.

l Type—The logging method that was selected when the log was configured.

l Start Time—For a Pending log, the scheduled start time is shown. For a Ready log
that has not yet started, this column displays “Manual.” For a Running or Stopped
log, the actual start time is shown.

l Scheduled Stop Time—For a log with a scheduled stop, the scheduled stop time is
shown. For a log without a scheduled stop time, this column is blank.

l Stop Time—For a Pending or Ready log, this column is blank. For a Running log,
the time of the last data point is shown. For a Stopped log, the actual stop time is
shown.

l Status—Each log has a specific status. See Log Status for details.

l Used Size—Kilobytes of instrument memory allocated for this log. For a Pending or
Ready log, the current size of the log configuration is shown. For a Completed log,
the size of the entire log file is shown. For a Running log, the current size of the
log up to the last data point is shown.

Log Status

The status of each log in the instrument is displayed in the Logging tab by a symbol
beside the log name, and in the Status column.

Ready—Manual Start log is ready to start.

Pending—Scheduled start log is ready to start at its programmed time, or when you
click the Start button.

Running—The log is actively logging data.

Suspended—The log has been paused (stopped temporarily).

Stopped—The log has been stopped, either manually or on a schedule.

Deleted—The log has been marked for deletion and will be deleted from the
instrument when memory is needed. The software manages this automatically.

Invalid—The log as programmed cannot be run.

Ready, Pending, Running, and Suspended logs are
considered active. Only one log can be active in the instrument.

Log Control Buttons

You can control the status of a log by selecting the log and clicking the appropriate
button in the Logging tab control panel:

The Start button starts a Ready or Pending log, or resumes a Suspended log.
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The Pause button pauses a Running log allowing you the option to resume it.

The Restart button restarts the selected Running log from the beginning. This can
be useful during aquifer testing using a logarithmic data collection schedule.

The Stop button permanently stops the selected Running log.

Log Operations

Use the buttons in the control panel to perform the following actions:

Create a new log.

The New button is disabled if a Ready, Pending, Running, or Suspended log is on the
instrument. When the instrument contains its maximum number of logs, the New button
is unavailable.

Edit (or review) the log configuration for a Ready, Pending, or Invalid log.

Delete the log. (Note that you must delete a log twice before it is permanently
removed.)

Download the log to a PC.

Sensors Tab

The Sensors tab lists the sensors in the instrument, along with their serial numbers and
calibration dates. Use the buttons in this tab to calibrate and configure sensors.

Calibrate

Use the Calibration button to calibrate sensors or to adjust a level reference that is
currently stored on the instrument. The Calibrate button is not available when the
instrument does not support calibration (e.g. BaroTROLL Instrument).

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to calibrate.

3. Click the Calibrate button .
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Configure

Use the Configure button to select parameter units and to configure parameters that
support configuration. Examples include Level/Depth, Specific Conductivity, and Total
Dissolved Solids. Parameters cannot be configured while the instrument is showing
live data on the Home screen or while the instrument contains an active log.

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to configure.

3. Click the Configure button .

When you configure the Level parameter using the Sensors tab,
the settings are stored in the instrument and are available for use
in Modbus, SDI-12, or analog communication. If desired, a
different configuration can be selected when setting up a log.

Device Setup Tab

The Device Setup tab allows you to set hardware settings and view instrument status
such as:

Device Information

l You can set the instrument name here. There is a 32-character limit. Type the
name and click the Set Name button. A device name cannot be set while the
device contains an active log.

l The other device-specific information displayed in this area is not user-
changeable.

l Manufacture Date
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l Firmware Version—If the firmware version is displayed with a red background, this
indicates a later version is available and the device should be updated.

l Hardware Version

l Boot Version—This is the software used by the device to upgrade its firmware.

Manual Time Set

You can set the instrument clock to a time other than the PC (system) clock. Select the
new time and click the Set Clock button.

Device Firmware Update

The Available Firmware drop-down list in the Device Setup tab displays all available
firmware for the connected device arranged by version from newest to oldest. To update
the device firmware, select the firmware version you want from the drop-down list and
click the Update Device button. Firmware cannot be upgraded while the device is
profiling or contains a log in the Ready, Pending, Running, Suspended, or Invalid state,
as shown on the Logging tab. Downgrading the device to a lower firmware version is
not recommended.

Device Status

This area of the Device Setup tab shows the details of instrument alarms and warnings
indicated by the bell-shaped alarm icon.

Status colors:

Gray—No alarms or warnings

Yellow—Warning

Red—Alarm

l Sensor High: An alarm or warning when values reported by a sensor have
exceeded a user-set "high" alarm or warning threshold.

l Sensor Low: An alarm or warning when values reported by a sensor have
dropped below a user-set "low" alarm or warning threshold.

l Sensor Calibration: A warning when factory calibration expires or when a user
calibration date has passed.

l Sensor Malfunction: This alarm lights when a water-quality sensor malfunctions.

l Hardware Reset: This warning indicates that the device has reset itself following a
serious interruption, such as a lightning strike. If the device clock is lost during
logging, the log will resume when the device recovers from the reset, at whatever
time is then active in the device. Disregard this warning for non-logging
instruments.

l Device Malfunction: An alarm is activated when the device has malfunctioned.
Call Technical Support.

l Low Battery: An alarm is activated when 5 percent of the device battery capacity
remains.
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l Low Memory: An alarm is activated when 5 percent of the device memory capacity
remains.

Buttons in this area of the Device Setup tab are used to set up alarms, clear alarms,
and take the device offline. To clear an alarm indicator, click the Clear Status button.

Factory Reset

To restore factory settings in the device (less any firmware upgrades), click the Factory
Reset button in the Device Setup tab.

A factory reset removes all logged data from the device. This button is not available if
the device is profiling or contains an active log.

Analog Setup

To configure the device for 4-20 mA output, click the Analog Setup... button in the
Device Setup tab.

SDI-12 Setup

To configure the SDI-12 output from the device, click the SDI-12 Setup... button in the
Device Setup tab.

Alarm Setup

To configure the instrument alarm and/or warning indicators, click the Alarm Setup...
button in the Device Setup tab.

Modbus Setup

These settings permit devices on a network and devices connected via a gateway such
as a modem or TCP/IP to be changed independent of the connection link. To configure
the device communication settings, click the Modbus Setup... button in the Device
Setup tab.

Win-Situ 5 Logging and Viewing Data

About Sites

All data logged by In-Situ instruments are tied to a specific site. A site represents the
physical location where the instrument collects data. For example, you can create a site
to represent a lake, gauging station, well, or nearby landmark.

You are prompted to select a site when you set up a data log. A default site is loaded
with the software, and can be used, but it does not provide any specific information
about the place where the data was collected.

l When you set up a new site, a Site folder with the same name is created in the
folder tree on the Data tab. Site folders are designated by this icon .

l When you set up a data log, the first thing you are asked to supply is a site.

l When you download a data log, it appears in its Site folder in the folder tree on the
first screen Data tab. See page 65. This provides a convenient way to organize
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data collected from the same instrument at different locations, or from different
instruments at a common location.

Sites are stored in a database on your computer in your Win-Situ working directory.
More information. After a new site is added, it is available to select for any instrument
and any log.

Only one site at a time is programmed in the instrument and it is shown in the Site box
at the top of the screen.

For additional information see:

Adding a New Site

Managing Sites

Logging Data—Overview

Win-Situ provides many ways to customize the collection of field data.

l Schedule the instrument to start and stop a log at a specified time.

l Set up a log and start it manually. While the instrument is connected to the
software, you can watch the first few readings in tabular or graphical form.
Disconnect from the software and let the instrument collect data. Manually
reconnect to the instrument and download the collected data at any time.

l Start a log, check the data, pause the log, reposition the device, restart the log.

l Download data logs to folders on your PC.

What do you want to do?

l Set up a new data log.

l Start a log that has been set up in the instrument.

l View the logs on the instrument.

l Download a log to my PC.

l Stop a log that is running on the instrument.

l Suspend (temporarily stop) a log that is running in the instrument.

l Delete a log from the instrument.

Logging Method Descriptions

The following is a list of log types and their descriptions. The log types that are
available on an instrument vary depending upon the capabilities of the instrument.

Logging Methods for Long-Term Monitoring

Linear

Linear log type measures and records at a user-defined fixed interval of one minute or
more. This method is used for long-term studies, landfill monitoring, stream gauging,
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tidal studies, and background monitoring prior to aquifer testing. Intervals are measured
in days, hours, or minutes.

Linear Average

Linear Average log type can smooth out anomalous highs and lows that may occur in a
data set, for example, when a water wave passes over the instrument. Each stored
measurement is the average of several rapid measurements. This method is used for
long-term studies, stream gauging, tidal and open-water studies where trends are more
important than accuracy. Intervals are measured in days, hours, minutes, or seconds.

Event

Linear Event log type combines basic fixed-interval logging of specified parameters
with the ability to log data at a faster interval when a single-parameter event condition is
present.

When logging conductivity, please note that the faster event interval logging can occur
only if external power is present.

Log Setup

The Log Setup Wizard presents sequential screens to help you supply all the
information necessary to set up a data log in the instrument.

To access the Log Setup Wizard the instrument must be connected to the software.

1. Click the Logging tab .

2. Click the New button .

The New button may be disabled or may show a warning if an
active log already exists on the instrument, or if the instrument is
polling live data (see the Home screen), or if the device already
contains its maximum number of logs.

3. Select the Site where the set of data will be logged and supply a name for the log.

4. Click the right arrow to continue after each step.

5. Select the parameters you intend to measure, choose the measurement units, and
specify the order in which the selected parameters will be logged.

6. Select the logging method you intend to use. See page 75.

7. Select the log interval. A log interval is how often a measurement will be taken and
stored.

8. Select the start condition, stop condition, and specify how to handle full device
memory.

9. If you selected Level or Depth as a parameter to measure, specify how you intend to
log this parameter. More information.
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10. If you selected Specific Conductivity as a parameter to measure, you have the
option to choose a method for converting actual conductivity to specific conductivity.

11. If you selected Total Dissolved Solids as a parameter to measure, you have the
option to edit the default conversion factor used to calculate total dissolved solids
from specific conductivity.

12. The final screen summarizes the log setup. Click the check mark to write this
information to the instrument.

Starting a Log

Every log is programmed for either a manual or a scheduled start. A log with a manual
start time is displayed in the Logging screen with Ready in the Status column. A log
with a scheduled start time is displayed with Pending in the Status column.

Starting a Pending Log

A Pending log automatically starts at the scheduled time without any user intervention.

A scheduled log with Pending status can be manually started at
any time before its scheduled start.

Starting a Manual Log

With the instrument connected to the software, select the Logging tab.

Select the Ready log you want to start.

Click the Start Log button . The log starts and the symbol changes. The Status
column displays Running.

Suspending (Pausing) a Log

A running log may be temporarily paused. For example, you might want to reposition an
instrument, calibrate a sensor, or clean a sensor and later resume the log. A log can be
suspended and resumed three times.

1. With the instrument connected to the software, select the Logging tab .

2. Select the log you intend to suspend.

3. Click the Suspend button . Suspended appears in the Status column.

Resuming a Suspended Log

1. To resume logging after a log has been suspended, select the Logging tab.

2. Select the Suspended log.

3. Click the Start Log button . Logging resumes. Running appears in the Status
column. The data file will show the time when the log was suspended and the time
when it restarted.
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Stopping a Log

A log can be manually stopped at any time, even if a stop time has been previously
scheduled. If you did not specify a stop condition when you defined the log, the log will
run until the instrument is out of memory or battery power, or until you manually stop it.

A log that has been stopped cannot be resumed. If you intend to
resume a log later, you should suspend a log rather than stop it.

1. To manually stop a log, the instrument must be connected to the software.

2. Select the Logging tab .

3. Select the running log you intend to stop.

4. Click the Stop Log button .

Restarting a Log

Restarting a log is useful when you are conducting aquifer testing and you want to
begin collecting rapid data without configuring and starting a new log.

1. The Restart Log feature is only available for a running log. In the Logging screen
select a running log.

2. Click the Restart Log button to restart the log from the beginning.

To resume a suspended log, use the Start Log button , not
theRestart Log button.

Downloading Data to a PC

This procedure copies the data log from the instrument to a PC. It does not remove the
data log from the instrument. After a log is downloaded, it can be exported to a CSV file
format that can be used by spreadsheet programs. The time shown in the log name is
the time the log was downloaded.

1. With an instrument connected, select the Logging tab .

2. Select the log you intend to download.

3. Choose a Running, Suspended, Stopped, or Deleted log.

4. Click the Download button.

5. In the next screen, select one of the three download options.

l All data

l New data (data logged since the last download)

l Time interval to download
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New data is downloaded by default to a new log file. To append
new data to the last download of this log, be sure the option
"Append logs on download" is selected in the General Settings
dialog (Preferences >General Settings).

2. The log is copied to the connected PC into your Win-Situ working directory folder.
View or change the working directory using File > Settings.

3. At the end of the download, Win-Situ gives you the option of viewing the data.

l Select Yes and the log is displayed in the Data screen.

l Select No and the Logging screen appears. You can view the data at
any time by selecting it in the Data tab.

Viewing Logged Data

1. To view the data stored in the instrument, you must first download the data. A
connection to an instrument is not needed after the data log has been downloaded.

2. Select the Data tab .

3. On the left side of the screen, select the log you want to view. To expand a folder
shown in the navigation tree, double-click the folder. The content of the data log is
displayed on the right side of the screen in text or graph format.

To switch between view formats, click the Text or theGraph
button in the control panel. To customize the text or graph view,
select Preferences > Graph Settings or Preferences >
Data View Settings. These options apply to all downloaded
data until you change the options.

Exporting Data

Exporting Data to Spreadsheet Format

1. Download the log from the instrument to your PC.

2. Select the Data tab .

3. On the left side of the screen, select the log you intend to export. The content of the
log is displayed on the right side of the screen.

To export all of the logs in the site, select the site.
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4. Select File menu > Export to CSV. The log is exported to the Exported Data folder
into a sub-folder with the same name as the data site of the log. If the folder does not
yet exist, Win-Situ creates it.

5. To open the CSV file, do one of the following:

l Double-click the exported file in the navigation tree on the left side of the Data tab

l Access the file in Windows Explorer and double-click the file (for example: C:\ My
Documents \ Win-Situ Data \ Exported Data \ my data site \ drawdown test 2006-
05-28 11-00-00).

Exporting to Text

To export one or more data logs to text format, follow the steps above, except at step 5
select File menu > Export to Text. Double-click the exported file to open it in Windows
Notepad or your default text editor.

Graphing Data

Real-time data and downloaded log data may be viewed in text (default) or graphic
form.

View a Graph of a Downloaded File

1. Click the Data tab .

2. Select a downloaded log file from the list on the left. Log files are located in the site
folders.

3. Click the Graph button .

View a Graph of Real-Time Data

1. With an instrument connected to the software, click the Home tab .

2. Click the Start button .

3. Click the Graph button .

Graph Settings

The initial display uses the default graph settings (Preferences menu > Graph
Settings) for all graphs. Each log file can have its own customized graph settings that
are saved with the log file.

The defaults are as follows.

l All log channels are shown in the order in which they were logged.

l X axis (time) is across the bottom and is auto-scaled.

l Y axis (values), one for each channel, are stacked along the left side of the graph
and are auto-scaled to show the full range of the data.
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Graph Templates

If you have saved any custom graph templates, you can select one with the Load
Template button.

Graph Tools

The graph control tools are described below. Each has a toolbar icon and a keyboard
shortcut. Holding down the shortcut keys temporarily switches the graph control mode.
When the shortcut is released, the graph returns to its previous control mode.

Name Tool Description Keyboard Shortcut

Pan

Click the tool, then drag inside the
graph to pan in any direction (left,
right, up, down). Real-time graph
update is paused (play button pops
up) but the cache continues to
update in the background.

Spacebar

Zoom In

Click the tool, then click in an area of
the graph to enlarge that area. Or
drag a selection box over a part of
the graph you want to see in greater
detail.

Ctrl + Spacebar

Zoom Out
Click the tool, then click in the graph
and the graph zooms out on that
area.

Ctrl + Alt + Spacebar

Cursor Click to cancel the Pan or Zoom tool. Release shortcut key(s)

Series Select

With the Data panel displayed, click
the tool, then slide it left or right over
the traces. The Data panel table
scrolls to the selected record.

None

Fit Graph
After panning or zooming, this tool
restores the default range settings for
the axes.

Ctrl + 0 (zero)

Configure Format and create templates for
graphs. None

Printing Print graph. None
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You can expand or compress the graph by clicking and dragging
anywhere in the X axis on the bottom of the graph. The real-time
graph update is paused but the cache continues to update in the
background.

Calibration

Calibrate Sensors

1. Ensure that the instrument is connected to the software, and select the Sensors tab.

2. Select the sensor you want to calibrate to activate the Calibration button.

3. Click the Calibration button.

4. Perform the steps in the calibration wizard.

Calibrating the Conductivity Sensor

The conductivity sensor is calibrated with NIST®-traceable standards at the factory,
which provides a high degree of linearity across the entire operating range. This sensor
is capable of meeting its published specifications without requiring additional
calibration by the user. Most commercially available standards can introduce a larger
potential measurement error than the sensor’s initial factory calibration.

User calibration is recommended only if you must conform to a standard operating
procedure or if the conductivity cell has undergone physical change (e.g., deposits on
conductivity cell walls that cannot be removed or physical damage to the conductivity
cell walls).

1. Prepare the instrument for calibration.

There should be no bubbles on the sensor face. Bubbles cause
inaccurate calibrations.

2. Connect the instrument to the computer.
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3. Connect the instrument to the software.

4. Go to the Sensors tab and select the conductivity sensor.

5. Click the Calibrate button .

If you want to restore the factory calibration, select the check box
and click the right arrow button.

6. Select either 20° C or 25° C as the reference temperature, as indicated by the
reference calibration solution.

7. Select the appropriate calibration standard from the drop-down list. If you select
“User Defined,” enter the value of the solution.

8. Click the right arrow button.
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9. Click OK to start the calibration.

Nominal Stability vs. Full Stability
To meet the criteria for a valid calibration point, the change in
sensor response is monitored over time. The software is looking
for the calibration solution temperature and the sensor readings to
settle over a specific time period. The criteria for Full Stability are
designed to meet the published specifications. The criteria for
Nominal Stability are designed to shorten the calibration time
when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check
mark to complete the calibration, or click Cancel to return to the previous calibration.

11. You can save or print the calibration report.

12. Click OK to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and
rinse both thoroughly with clean water.

Calibrating the Pressure Sensor

When a vented instrument is in air (rather than deployed in water) and displays a
pressure/level value other than zero, you can calibrate to compensate for electronic
drift. If the sensor reading is outside the specified accuracy of the pressure sensor, send
the instrument to In-Situ for factory calibration.

Do not calibrate an absolute pressure sensor because this removes barometric
pressure (at a single point in time) and causes errors when you post correct the data
using a BaroTROLL Instrument.

1. Connect the instrument to the computer.

2. Connect the instrument to the software.



1-970-498-1500 85 www.in-situ.com

3. Go to the Sensors tab and select the sensor.

4. Click the Calibration button .

5. Select the pressure parameter from the drop-down list and select Calibrate.

6. Select the Zero the Level/Pressure sensor option.

7. Ensure the pressure sensor is dry and exposed to air.

8. Click the check mark. The pressure reading is reset to zero.

Calibrating the RDO Sensor

You can perform a one-point 100% Oxygen Saturation calibration or a two-point
calibration that also includes a 0% Oxygen calibration depending on your application
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needs.

Calibrate 100% Oxygen Saturation

1. Prepare the instrument for 100% Oxygen Saturation calibration.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the RDO Sensor.

5. Click the Calibrate button .

If you want to restore the factory calibration, select the option and
click the right arrow button.

6. By default, 100% saturation is selected for the first point of the calibration. If you
intend to perform a 2-point calibration, also select 0% saturation from the drop-down
list. Otherwise, leave as None.

7. Click the right arrow button.

8. Enter the barometric pressure or elevation at which the instrument will be deployed.

9. Click the right arrow button.

10. Click OK to start the calibration.

Nominal Stability vs. Full Stability
To meet the criteria for a valid calibration point, the change in
sensor response is monitored over time. The software is looking
for the calibration solution temperature and the sensor readings to
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settle over a specific time period. The criteria for Full Stability are
designed to meet the published specifications. The criteria for
Nominal Stability are designed to shorten the calibration time
when an approximate calibration is acceptable.

11. When the screen indicated that the calibration has reached stability, click the check
mark to complete the calibration, or click Cancel to return to the previous calibration.

Calibrate 0% Oxygen Saturation

1. If you selected to perform a 2-point calibration, you are prompted to set up the
solution for the second point of the calibration.

2. Remove the wet sponge from the cup.

3. Fill the calibration cup to the fill line with approximately 130 mL of fresh sodium
sulfite solution.

4. Completely submerge the RDO Sensor into the solution.

5. Click OK, to start the calibration.

6. When the screen indicates that the calibration has reached stability, click the check
mark to complete the calibration, or click Cancel to return to the previous calibration.

7. You can save or print the calibration report.

8. Click OK to complete the calibration.

9. Once calibration is complete, remove the instrument from the calibration cup and
rinse both thoroughly with clean water.

Calibrating the pH/ORP Sensor

1. Prepare the instrument for calibration.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the pH/ORP sensor.
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5. Click the Calibrate button .

If you want to restore the factory calibration, select the option and
click the right arrow button.

6. Select Calibrate pH or Calibrate ORP, and click the right arrow button.

7. Select the appropriate calibration standard from the drop-down list. If you select
User Defined, enter the value of the solution.

8. Click the right arrow.

9. Click OK to start the calibration.
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Nominal Stability vs. Full Stability
To meet the criteria for a valid calibration point, the change in
sensor response is monitored over time. The software is looking
for the calibration solution temperature and the sensor readings to
settle over a specific time period. The criteria for Full Stability are
designed to meet the published specifications. The criteria for
Nominal Stability are designed to shorten the calibration time
when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check
mark to complete the calibration, or to continue to the next calibration point. Click
Cancel to return to the previous calibration.

11. You can save or print the calibration report.

12. Click OK to finish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and
rinse both thoroughly with clean water.

Calibrating the Turbidity Sensor

1. Prepare the instrument for calibration.

There should be no bubbles on the sensor face. Bubbles cause
inaccurate calibrations.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.

4. Go to the Sensors tab and select the Turbidity sensor.
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5. Click the Calibrate button .

If you want to restore the factory calibration, select the option and
click the right arrow button.

6. Select the appropriate calibration standard from the drop-down list for calibration
point 1. If you select User Defined, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration
point 2 if necessary. If you select User Defined, enter the value of the solution.

8. Click the right arrow.

9. Click OK to start the calibration.

Nominal Stability vs. Full Stability
To meet the criteria for a valid calibration point, the change in
sensor response is monitored over time. The software is looking
for the calibration solution temperature and the sensor readings to
settle over a specific time period. The criteria for Full Stability are
designed to meet the published specifications. The criteria for
Nominal Stability are designed to shorten the calibration time
when an approximate calibration is acceptable.

10. When the screen indicates that the calibration has reached stability, click the check
mark to complete the calibration, or to continue to the next calibration point. Click
Cancel to return to the previous calibration.

11. You can save or print the calibration report.

12. Click OK to finish the calibration.
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13. Once calibration is complete, remove the instrument from the calibration cup and
rinse both thoroughly with clean water.

Calibration Reports

Saving Calibration Reports

At the end of a successful calibration procedure you are prompted to print and/or save
the calibration report.

If you select to save the report, the Windows save file dialog opens and allows you to
complete the action.

Viewing Calibration Reports

You can view saved calibration reports on the Data tab or in your working directory.

To find the location of your working directory for Win-Situ 5, go to Preferences menu >
Working Directory.

BaroMerge

Using BaroMerge Software

BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to
eliminate barometric pressure effects from the measurements. BaroMerge Software can
be accessed through the Win-Situ 5 Software Tools menu. BaroMerge provides three
options to correct data.

l Fixed Correction—A single offset value is applied to all selected log data. Use this
option if you know the barometric pressure of the site during the log, and know
that it did not change.

l Manual Entry—Specify two or more correction values to apply to the log data. Use
this option if you wish to manually enter a data set of barometric pressure values.

l BaroTROLL log file—Absolute level sensor data points are individually corrected
to reflect barometric pressure changes that were logged by a BaroTROLL
instrument during the approximate time period.
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Baro Merge Input—Manual Entry

When you select the Fixed Correction and Manual Entry options, it is important to
know the barometric pressure for the general time period covered by the log or logs you
want to correct.

1. From the Tools menu, select Win-Situ BaroMerge.

2. Select the Enter one or more values manually option.

3. The compensation table appears that allows you to build a table of barometric data
that corresponds to the time the log was recorded. The compensation table has
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three preference options:

l The first option, Save calculated barometric adjustments in the new data file(s)
is the default option. It adds additional columns depending on which parameters
were selected for the absolute/non-vented log in the corrected BaroMerge file that
uses the compensation table values. This is intended to show how the
adjustments were done in the BaroMerge file. If you do not want to show these
adjustments, clear this option.

l When the second option, Show time in UTC is selected, the compensation table
time stamp displays in Coordinated Universal Time (UTC) time, formally known
as Greenwich Mean Time (GMT).

l If the third option, Ignore daylight saving time (DST) is selected, the
compensation table time stamp format without the daylight savings time
adjustment will be shown.

3. Build a table that contains at least two barometric pressure values.

4. Click the right arrow and select the absolute (non-vented) log file or files you intend
to correct.

5. Click the check mark and the barometric compensation is applied.

6. Compensated data files can be viewed or exported from the Data tab.

Baro Merge Input—Fixed Correction

If you select the Apply a fixed correction option, a single correction is applied to all
values in the log.

To use this correction method you need barometric pressure values from a reliable
source. Choose a single value that represents the actual ambient barometric pressure
during the time period the log was recorded. You also need to know the file names of
the logs you want to correct.



1-970-498-1500 94 www.in-situ.com

1. From the Tools menu, select Win-Situ Baro Merge.

2. Select the Apply a fixed correction option.

3. Enter the barometric correction value and select units from the drop-down menu.

4. Click the right arrow button.

5. Select the log files to which the correction will be applied and click the check mark
button.

6. Compensated data files can be viewed or exported from the Data tab.

BaroMerge Input—BaroTROLL File

Log files that contain absolute data can be barometrically compensated using values
logged by the In-Situ Inc. BaroTROLL Instrument. Select this method when you have
access to a BaroTROLL log file covering approximately the same time period as the
data file you intend to correct.

To use this correction method, you need the name of the BaroTROLL log file and the
name(s) of the absolute log file(s) you want to correct.
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1. From the Tools menu in Win-Situ 5 Software, select Win-Situ BaroMerge.

2. Select the "Use a BaroTROLL file:" option.

3. Click the browse button to the right of the file field.

4. Select a BaroTROLL file and click the check mark.

5. Values from the BaroTROLL file will be displayed in the next window. You can edit
these values if necessary.

6. Click the right arrow button.

7. Select the log file(s) you intend to correct and click the check mark.

8. Compensated data files can be viewed or exported from the Data tab.

BaroMerge Output

Your original log file is not changed. A new, corrected log file with the same name and
path is created. The original “.wsl” extension is replaced by “-Baro Merge.wsl”.

Post Level Correction within Baro Merge

It is also possible to post correct a level reference in data collected from an absolute
sensor if the data has been compensated through Baro Merge Software.

1. Follow the steps to compensate the absolute data for barometric pressure.

2. When you reach this screen in the Wizard, you can select the check box to Post
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correct files for level.

Managing Data from Multiple Sites
You can organize and group sites to simplify your data management.

Adding a Site

You can add a new site to the site database in the Win-Situ working directory. After a
new site is added, it is available to select as the current site for any instrument.

Editing a Site

You can edit a site to add information that was not available when the site was created,
refine a site name (within the 32-character limit), add a site note. If an instrument is
connected to the software and it has a running or suspended log, you cannot edit the
current site.

1. In the Data tab, select the Site button .

2. Edit site information.

3. Click Save to save the changes.

Deleting a Site

Deleting a site removes it from the site database in your Win-Situ working directory. The
site and the data files will be deleted. If the software is connected to an instrument with
a running or suspended log the current site cannot be deleted. If while disconnected
you inadvertently delete a site that is stored in one of your instruments, Win-Situ will
restore it the next time you connect to the instrument.

1. In the Data tab, expand the Site Data folder and right-click the site.

2. Select Delete.

Using Site Groups

Site Groups allow you to organize sites, and therefore data, by customer, region,
contract, project, etc. For example, if a project for the XYZ corporation has several
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different sites where data are logged, you could create a site group called XYZ and
drag the appropriate sites into the group on the Data tab.

Creating a Site Group

1. In the Data tab, select the Site Data folder.

2. Click the File menu > New > Site Group.

3. Enter a name for the site group. A site group name can have up to 100 characters.

4. Click Save.

5. The new site group appears in the folder tree with the symbol . The site group does
not yet have sites associated with it.

6. To place existing sites into your new site group, select one or more sites in the
folder tree, drag and drop them under the new group.

Site-Based Connections

Win-Situ allows you to create connection configurations for individual sites. In this way
you can easily maintain different communication setups for different sites. The site
connection configuration dialog lets you configure and name a connection for the site.
When first created, the site connection settings are initialized from the default
communication settings (Preferences menu > Comm Settings).

Creating a Custom Connection

1. In the Data tab, select the Connections folder.

2. Select File > New > Connection.

3. Enter a name for the new connection.

4. Select the options you want for the new connection.

5. Click Save.

Using a Custom Connection

1. Open Win-Situ but do not connect to the instrument.

2. Select the custom connection in the folder tree on the Data tab.

3. Click the Connect button to connect to the instrument using the custom
configuration.

Storing Custom Connection for a Site

Once a custom connection has been created, it will appear in the Connections area of
the Site Information screen and can be selected for use with any site.
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Correcting a Level Reference in Data Files

About Post Correcting Level Data

In specific cases, it is possible to correct a level reference in a data file after you have
stopped the log and downloaded the data. The following criteria must be met in order
for a level reference to be post corrected in a data file.

l Data must be compensated for barometric pressure before the level reference can
be corrected. Therefore, data must come from a vented instrument, or if it is from
an absolute instrument, it must be compensated through Baro Merge Software
before the level reference can be corrected.

l The data file must already contain a level mode.

l The data file must have been created with Win-Situ version 5.6.0.0 or higher in
order to post correct for the Depth reference type.

l The data must have been downloaded with Win-Situ version 5.6.24.4 or higher.

l If the log was originally set to "Zero at start of test" and the user has made
changes to the level reference during logging, it is not possible to correct the data
with Win-Situ.

Files that have been corrected are stored in a subdirectory named "Post Corrected
Files" and "PostLevelCorrection" is added to the file name. The original data file is not
altered.

Open Post Level Correction

Post Level Correction can be accessed through Win-Situ 5 Software or through the
Baro Merge Software.

1. To open Post Level Correction in Win-Situ 5 Software go to the menu bar and click
Tools > Post Level Correction.

2. The software loads the compatible files. Expand the site that contains the data file
you intend to correct and select the file.
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3. Click the right arrow.

You can also access Post Level Correction in Baro Merge
Software. To open Post Level Correction within Baro Merge,
check the appropriate check box in the Baro Merge Wizard. See
page 95.

Select Level Reference Type

In order to post correct the level reference in a data file, the original data must have
been collected in level mode.

1. You can keep the original level reference type, or you can select one of the
following reference types.

l Pressure head (Depth)

l Depth to water

l Elevation or gauge height/stage

2. Click the right arrow.
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Set the Level Correction

1. Select Set level reference (Reference point set at test definition) if you want to
change the level reference at the time you originally set up the log.

2. Select Set level reference (Reference at user selected data point) if you measured
your level reference at any point after the start of the test. You must then select the
time from which to apply the correction. The level correction will be applied to all
data collected after the selected point.

3. Enter the correction value in the Level reference field.

4. Click the right arrow button.

5. Select a value for specific gravity and click the right arrow button.

This step is necessary only if the value for specific gravity was set
incorrectly in the original file.

Click the Correction summary button to view the changes before
you apply them to the file.

6. When post correction is complete, click the check mark button.
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View Post Level Corrected Data

1. To view post corrected level data, go to the Data tab.

2. Open the appropriate site in the Site Data folder.

3. Files that have been corrected are stored in a subdirectory (on your hard drive)
named "Post Corrected Files" and "PostLevelCorrection" is added to the file name.
The original data file was not altered.

4. You can view the data in Win-Situ 5 or export the data to Excel.

See page 79.

Win-Situ 5 Troubleshooting

Selecting the Correct COM Port

If you are using a USB TROLL Com, select the correct COM port by following the steps
below. If you are using a serial TROLL Com, the Win-Situ Software should default to
the correct COM port, which is usually COM 1.

Steps for Windows 8 systems.

1. Right-click the Start screen.

2. Select All Apps.

3. Click Control Panel.

4. Open the Device Manager.

5. Click the arrow next to Ports (Com and LPT), and locate the USB Serial Port listing.
The number listed next to this entry is your COM port address.

Steps for Windows 7 systems.
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1. Minimize the Win-Situ Software.

2. Click the Windows Start button, and open the Control Panel.

3. Click Hardware and Sound, and open the Device Manager.

4. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port
listing. The number listed next to this entry is your COM port address.

Steps for Windows XP systems.

1. Minimize the Win-Situ Software.

2. Click the Windows Start button, and open the Control Panel.

3. Double-click the System icon. Click the Hardware tab, and open the Device
Manager.

4. Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port
listing. The number listed next to this entry is your COM port address.

The following steps apply for all Windows operating systems.

1. Once you have determined the correct COM port address in your operating system,
reopen Win-Situ 5 Software.

2. Close any open windows in Win-Situ Software.

3. Click Preferences.

4. Click Comm Settings, and then click the Port Number menu.

5. Scroll down to find the correct COM port address. Click the check mark to accept
the changes.

6. Click the yellow Connect button in the lower right corner to establish a connection to
the instrument.

Bluetooth Connection

If you are trying to connect via Bluetooth but cannot establish a connection, try the
following:

l Locate your Bluetooth settings and ensure Bluetooth is turned on.

l Ensure your computer is paired with the instrument. In your Bluetooth settings you
should see the instrument serial number and "Paired."

l Ensure you have selected the correct COM port in Win-Situ 5 Software.

l Ensure you have clicked the connect button in the bottom right corner of the Win-
Situ 5 screen.

l Ensure the communication settings for Win-Situ 5 match the device. See
"Connecting with Bluetooth" on page 42.
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Water Quality

pH

What is pH?

The term pH is derived from "p" meaning power and "H" for the element hydrogen and
literally means "power of hydrogen." pH is defined as the negative logarithm of the
hydrogen ion activity (or concentration in moles/liter):

pH = -log [H+] or [H+] = 10-pH

Water (H2O) dissociates into hydrogen ions (H
+) and hydroxide ions (OH-) in aqueous

solution. At 25°C there are 1.0 x 10-7moles/L of hydrogen ions and 1.0 x 10-7moles/L
of hydroxide ions in pure water. Thus the water is nuetral (pH = 7) because there are
equal amounts of each ion. Addition of a substance with hydrogen or hydroxide ions
will shift the balance and cause the water to become either acidic or basic.

The pH scale ranges from 0 (most acidic) to 14 (most basic or least acidic). A change of
1 pH unit corresponds to a tenfold change in hydrogen ion concentration.

Why Measure pH?

A pH value indicates the amount of hydrogen ion that is present in an aqueous
environment. The hydrogen ion concentration gives an indication of the acidity of a
substance. pH is an important measurement in natural waters because most chemical
and biochemical processes are pH dependent. The physiological chemistry of most
living organisms can tolerate only small changes in pH and still provide the chemical
reactions to sustain life. The solubility of many chemicals is pH dependent. Thus, pH
determines their availability to living organisms.

Typical pH values

Fluid pH units

Acid rain <5

Distilled water 5.6

Most nautral waters 8

Safe for freshwater fish 6-9

Properly chlorinated swimming pool 7.2 - 7.6

Natural waters usually have pH values in the range of 4 to 9. Most natural waters are
slightly basic (approximately pH 8) because of the presence of carbonates (CO3

2-) and
bicarbonates (HCO3

-). Extremely fresh water can even be slightly acidic (approximately
pH 6), depending on the concentration of dissolved carbon dioxide (CO2). The carbon
dioxide combines with water to form a small amount of carbonic acid (H2CO3) and this
process lowers the pH. Nitrogen oxides (NOx) and sulfur dioxides (SO2) from
automobile exhaust and the burning of coal combine with water in the atmosphere to
form nitric (HNO3) and sulfuric acid (H2SO4). This falls to the ground as acid rain and
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accumulates in surface water. Runoff from mining spoils and the decomposition of plant
materials can also cause acidic surface water.

pH values below 5 in natural waters are generally considered to be too acidic for most
aquatic organisms. Freshwater fish survive best in the pH range of 6 to 9. Acidic
drinking water is a concern due to its corrosive characteristics to plumbing and
appliances. pH affects the ammonia/ammonium (NH3/NH4

+) equilibrium in water. Even
a small ammount of ammonia is detrimental to fish while a moderate ammount of
ammonium is tolerated. At a pH of 6.5 almost all ammonia is in the form of ammonium.
However, as the pH becomes slightly basic, ammonium is changed into harmful
ammonia. The lethal dose of ammonia for trout is only 0.2 mg/L.

The pH/ORP Sensor

The single-junction, three-electrode sensor uses a potentiometric method to measure
the pH of a solution. The sensor consists of a pH-sensitive glass whose voltage is
proportional to the hydrogen ion concentration. The ORP electrode serves as an
electron donor or acceptor depending upon the solution. A second sensor (electrode)
serves as a reference, which supplies a constant stable output. Electrical contact is
made with the solution using a saturated potassium chloride (KCl) solution. The
electrode behavior is described by the Nerst equation:

Em = Eo + (2.3RT/nF) log [H
+]

where

Em is the potential from the pH electrode,
Eo is related to the potential of the reference electrode,
R is the Gas Law constant,
F is Faraday's constant,
T is the temperature in Kelvin,
n is the ionic charge (+1 for Hydrogen), and
[H+] is the hydrogen ion concentration in moles/L.

The instrument reads the signal from the pH electrode, the reference electrode, and the
temperature and then calculates the pH using the Nerst equation.

Oxidation-Reduction Potential

What is ORP?

Oxidation-Reduction Potential (ORP) is a measure of a water system's capacity to
either release or gain electrons in chemical reactions. The process of oxidation
involves losing electrons while reduction involves gaining electrons. Oxidation and
reduction (redox) reactions control the behavior of many chemical constituents in
drinking water, waste water, and aquatic environments. The reactivity and solubility of
critical elements in living systems is strongly dependent on redox conditions. ORP
values are used much like pH values to determine water quality. While pH values
characterize the relative state of a system for receiving or donating hydrogen ions
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(acting as a base or an acid), ORP values are affected by all oxidizing and reducing
agents, not just acids and bases.

Why Measure ORP?

The effect that potable water has on plumbing is directly related to its ORP value.
Unfavorable values can cause excessive corrosion, leading to expensive repairs. ORP
is one parameter that can be monitored during the disinfecting process for drinking
water, swimming pool water, and spa water.

The life expectancy of bacteria in water is related to ORP. In fact, studies have shown
that the life span of bacteria in water is more dependent on the ORP value than on the
chlorine concentration. For swimming pools at a normal pH value between 7.2 and 7.6,
the ORP value must be kept above 700 mV to kill unwanted organisms. Hypochlorite or
other oxidizing agents must be added when the ORP falls below 700 mV. In contrast,
natural waters need a much lower ORP value in order to support life.

Typical ORP values

Fluid ORP (mV)

Salt water aquarium ~ 350

Harmful to aquatic life > 400

Properly chlorinated swimming pool > 700

Generally ORP values above 400 mV are harmful to aquatic life. Ideally the ORP value
in salt water aquariums should be kept between 350 and 390 mV. ORP levels below
300 mV are to be avoided. An oxidizing environment is needed to convert any ammonia
(NH3) to nitrites (NO2

-) and nitrates (NO3
-). Ammonia levels as low as 0.002 mg/L can

be harmful to some fish species.

The determination of ORP is particularly worthwhile in water that contains a relatively
high concentration of a redox-active species, e.g., the salts of many metals (Fe2

+, Fe3
+)

and strong oxidizing (chlorine) and reducing (sulfite ion) agents. Thus, ORP can
sometimes be utilized to track the metallic pollution of ground- or surface water, or to
determine the chlorine content of wastewater effluent. However, ORP is a nonspecific
measurement—that is, the measured potential is reflective of a combination of the effects
of all the dissolved species in the medium. Because of this factor, the measurement of
ORP in relatively clean environmental water (ground, surface, estuarine, and marine)
has only limited utility unless a predominant redox-active species is known to be
present. Care is required not to "over-interpret" ORP data unless specific information
about the site is known.

The pH/ORP Sensor

The single-junction, three-electrode sensor uses a potentiometric method to measure
the ORP of a solution. The sensor consists of a pH-sensitive glass whose voltage is
proportional to the hydrogen ion concentration. The ORP electrode serves as an
electron donor or acceptor depending upon the solution. A second sensor (electrode)
serves as a reference, which supplies a constant stable output. Electrical contact is
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made with the solution using a saturated potassium chloride (KCl) solution. The
electrode behavior is described by the Nerst equation:

Em = Eo - (RT/nF) ln {[ox] / [red]}

where

Em is the potential from the ORP electrode,
Eo is related to the potential of the reference electrode,
R is the Gas Law constant,
F is Faraday's constant,
T is the temperature in Kelvin,
n is the number of electrons,
[ox] is the oxidant concentration in moles/L, and
[red] is the reduction concentration in moles/L.

Most natural waters contain many species that are involved in the redox process so that
it is not possible to calculate the ORP using the Nerst equation. All redox species do
however reach equilibrium. A Standard solution of known redox protential for a
particular ORP electrode is used to calibrate ORP. The sensor then gives a calibrated
response in mV when placed in a sample.

Conductivity

What is Conductivity?

Electrical conductivity measures the ability of a material to carry an electric current.
Lakes, rivers, oceans, and underground aquifers are typically good conductors because
they contain dissolved salts and minerals. These salts and minerals dissociate in the
presence of water to form negatively and positively charged particles called anions and
cations. Anions and cations provide provide a pathway for the transportation of
electrical chargers throughout the aqueous medium. For the most part, the higher the
concentration of dissolved salts and minerals in water, the better the conductor and the
higher the electrical conductivity. Deionized/distilled water is a poor conductor because
almost all anions and cations are removed during the deionization/distillation process.

Why Measure Conductivity?

Changes in the conductivity of a body of water are often used to indicate an
environmental event. For example, a drastic increase in the electrical conductivity of an
underground fresh water aquifer located near the ocean could indicate the beginning of
salt water intrusion. Contrarily, an increase in the electrical conductivity of a small lake
that is completely surrounded by farmland may simply be the result of runoff from a
recent rain.

How is Conductivity Measured?

Conductance is the reciprocal of the resistance, in ohms, measured between two
opposing electrodes of a 1 cm cube at a specific temperature. The unit 1/ohm or mho
was given the name of Siemens (S) for conductance. It is not practical to require all
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conductance cells to have the dimensions of a exact cube. To enable the comparison of
data from experiments with different conductance cells, the conductance is multiplied
be the cell constant to give conductivity in Siemens per centimeter (S/cm). Cell
constants are determined for each sensor using a standard solution of known
conductivity. The cell constant depends on the electrode area and the amount of
separation or distance between the electrodes.

Typical Conductivity values

Fluid Conductivity Value

Ultra-pure distilled water 0.05 µS/cm

Distilled water 1.0 µS/cm

Drinking water 50 to 300 µS/cm

Surface water 100 to 10,000 µS/cm

Sea water 40,000 to 55,000 µS/cm

Great Salt Lake 158,000 µS/cm

Early conductivity measurements were performed using cells with two electrodes. This
method required using three conductivity cells with different cell constraints in order to
span the range of 1 to 100,000 microSiemens per centimeter (µS/cm). Another
inconvenience occured when deposits formed on electrodes, thus reducing the
measured conductivity of the sample.

The modern four-electrode conductivity cell offers many advantages over the two-
electrode method. It contains two drive electrodes and two sensing electrodes. The
sensing electrodes are positioned in a low current area so that electrode fouling is
minimized. An alternating current is used to drive the cell. This reduces errors caused
by polarization resulting from the application of direct current.

Dissolved Oxygen

What is Dissolved Oxygen?

The amount of dissolved oxygen (DO) in both natural water and wastewater is a
function of several parameters. DO is highly dependent on temperature and
atmospheric pressure. An increase in temperature causes a decrease in the amount of
oxygen that can dissolve in water. Conversely, higher atmospheric pressures result in
higher DO values. Salinity is also a factor. Oxygen solubility is greater in freshwater
than in salt water. There are also chemical and biochemical processes that affect DO.

Most of the dissolved oxygen in water comes from the atmosphere, but oxygen from the
photosynthesis of aquatic plants is also a key source. DO levels in lakes and other
surface water will actually follow a cyclic or diurnal pattern over the course of a day,
rising and falling as light intensity changes from dawn to dusk.
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Why Measure DO?

Most aquatic life requires an average DO value greater than 5.0 milligrams dissolved
oxygen per liter of water (mg/L) in order to survive. Although the amount of dissolved
oxygen in a body of water fluctuates due to natural processes, large deviations from
normal levels are usually a result of human activity. Changes in DO levels are usually
the result of a buildup in organic waste. Organic waste can enter surface water from
treatment facilities, runoff from agricultural feed lots or domestic areas, and from
industrial discharge. Organic wastes often contain nitrates and phosphates. Nitrates
and phosphates are nutrients for aquatic plants and algae, stimulating overproduction
when present in excessive levels. Accelerated growth of blooms increase the number
of photosynthesizing plants, which temporarily increases the amount of dissolved
oxygen. However submerged aquatic vegetation eventually experience a reduction in
sunlight die to increased coverage on the surface. This decrease in sunlight leads to a
reduction in photosynthesis and eventual death. Bacterial processes take over and
consume even more dissolved oxygen. Fish and other aquatic species die due to lack
of dissolved oxygen. This tragic process is know as eutrophication.

Typical DO values

Conditions DO Value

100% DO, 0°C, 1 atm, 0 ppm Chlorine* 14.6 mg/L

100% DO, 20°C, 1 atm, 0 ppm Chlorine 9.09 mg/L

100% DO, 0°C, 0.75 atm, 0 ppm Chlorine 6.77 mg/L

100% DO, 20°C, 1 atm, 20 ppm Chlorine 7.35 mg/L

Safe level for most aquatic life > 5.0 mg/L

How is DOMeasured?

Traditional methods for DO determination include the Winkler titration method and
electrochemical methods, such as polarographic (Clark cell) and galvanic probes. With
electrochemical methods, molecular oxygen is consumed by an electrochemical
process. Two dissimilar metal electrodes (anode and cathode) are in contact with an
electrolyte solution. A semi-permeable membrane separates the electrodes from the
sample. As oxygen molecules diffuse through the semipermeable membrane, they are
reduced at the cathode to form positively charged ions. The ions migrate to the anode
where an oxidation reaction occurs. The oxidation/reduction reaction generates an
electrical current that is directly proportional to the oxygen concentration.

Optical sensor technology takes a different approach to quantifying DO. Originally
introduced in the 1970s, recent developments have allowed for the production of cost-
effective probes that operate in demanding environments.The RDO optical dissolved
oxygen sensor measures dissolved oxygen using the principle of "dynamic
luminescence quenching." Certain molecules, called "lumiphores," floresce when
excited by light of a specific wavelength. Oxygen molecules act to quench this



1-970-498-1500 109 www.in-situ.com

florescence. The lumiphores in the sensor are embedded in a gas-permeable sensing
foil in a replaceable cap.

The sensor optics include a lens, blue LED and filter, red LED and filter, and a
photodetector. When the blue LED emits light, the sensing foil emits red photons; the
presence of oxygen in the foil causes a reduction in red light detected by the
photodiode. The phase difference between the blue excitation light and the returned red
light is measured, and the result is used to compute dissolved oxygen.

This method measures the phase shift (or delay) of the returned signal, and is thus
based on the "lifetime" rather than the "intensity" of the luminescence.

Turbidity

What is Turbidity?

Turbidity is an indirect measure of the clarity or transparency of water, and thus is an
important indicator of its condition and productivity. Created by suspended matter and
microscopic organisms, turbidity causes light to be scattered and absorbed rather than
transmitted directly through water. Turbidity is the physical characteristic of the solution
that causes light scattering. Turbidity is the opposite of clarity.

The American Public Health Association (APHA) reference word Standard Methods
(Eaton and others, 2005) defines turbidity as "an expression of the optical property that
causes light to be scattered and absorbed rather than transmitted with no change in
direction or flux level through the sample."

Turbidity is not:

l a direct measure of clarity.

l a measure of color.

l a measure of suspended solids; it is a measure of their light scattering abilities.

Why Measure Turbidity?

Turbidity measurements :

l can provide a reasonable estimate of the total suspended solids or sediments
(TSS) concentration in water.

l can tell us something about the health of a natural water body. Clear water lets
light penetrate more deeply int a lake or stream than does murky water. This light
allows photosynthesis to occur and oxygen to be produced.

l can be a useful indicator of runoff into surface water systems.

l in flow-cell or in-line applications, when pumping water at very low rates, can
provide a good indication of true formation water.

Typical Turbidity values
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Fluid Turbidity Value

EPA drinking water 0.3 to 0.5 NTU

Treated water 0 to 1 NTU

Fresh water, >21.5 in. visibility < 10 NTU

Fresh water, 2.5 in. visibility 240 NTU

Short-term stress to aquatic life > 10 NTU

Unsafe level for most aquatic life >100 NTU

Higher turbidity levels can make it more costly to treat surface water for use as drinking
water. Controlling turbidity may be an effective way to protect against pathogens in
drinking water.

Aesthetic considerations also play a role in our desire to quantify turbidity: Most people
would rather look at, drink, or swim in clear water than in water that appears cloudy, and
closely associate appearance with the health of the body of water.

How is Turbidity Measured?

Historical methods for measuring turbidity relied on subjective estimates that depended
largely on the eye of the beholder.

In the Jackson Candle method, for example, a candle flame is observed through the
length of a glass tube into which a fluid sample is poured until the rays of transmitted
and scattered light appear equal and the flame essentially disappears. Among several
drawbacks to this method, the reproducibility of standards formulated from natural
sediments was diffcult to control.

The Secchi diskk method used in limnological studies involves submerging a weighted,
black-and-white painted metal plate until the pattern can no longer be detected. The
plate is then pulled up until it is visible again. The average of the two depths provides
an estimate of water clarity or transparency.

Modern turbidimeters measure the loss in intensity of a beam or a light beam as it
passes through a solution containing suspended and dissolved particles that are large
enough to scatter the light. The method is based upon a comparison of the intensity of
light scattered by the sample with the intensity of light scattered by a standard reference
suspension. The nephelometer is a particular type of turbidimeter that measures the
intensity of light scattered at right angles (90°) to the incident light. This lessens the
difficulty of differentiating small changes against a large background. Standards for
turbididty-measurement instruments specifiy the light source, angle, wavelength, beam
width, and sample suspensions, among other factors. Many of today's commonly
accepted procedures (e.g., Standard Methods, EPA, and ISO) apply to laboratory
bench-top instruments.
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Care and Maintenance

Maintenance Schedule
For best results, send the instrument to the manufacturer for factory calibration every 12
to 18 months.

User-Serviceable Parts
The user-serviceable parts on the instrument include the O-rings, the RDO, pH/ORP,
conductivity, temperature, and turbidity sensors, and the RDO Sensor Cap.

O-rings
The instrument has several O-rings that can be maintained by the user in order to keep
moisture from entering the instrument and damaging the electronics. Apply a very thin
layer of vacuum grease to new O-rings upon installation. Check O-rings for cracks,
chips, or discoloration and change when any of these conditions appear.

pH/ORP Sensor Replacement
To replace the pH/ORP sensor or to refill the reference junction, follow the instructions
in the pH/ORP Sensor Instruction Sheet that is included with the replacement sensor.

RDO Sensor Cap Replacement
The RDO Sensor Cap has a 2-year typical life. Follow the instructions included in the
RDO Sensor Cap Replacement Kit. Replacement caps are available from In-Situ Inc. or
your authorized In-Situ distributor.

Instrument Storage

Short-term Storage (<1 Week)

The restrictor can be used as a storage cup.

1. Remove the restrictor from the sonde body.

2. Remove the blue end cap from the restrictor.

3. Screw the blue end cap on to the restrictor end opposite of the flow-through holes.

4. Pour 15 mL (5 oz) of clean water into the restrictor.

5. Screw the restrictor on to the sonde.

Long-term Storage (>1 Week)

1. Remove the pH/ORP sensor and place a sensor port plug into the empty pH/ORP
port.

2. Add a small amount of pH Storage Solution (0065370) or pH 7 calibration solution
(0083210) to the sponge in the pH/ORP storage cap.
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3. Place the cap firmly on the sensor. Use electrical tape to seal the cap to the sensor.

Electrical tape prevents the sponge from drying out and keeps
crystals from forming on the sensor body.

4. Place a dust cap on the sensor connector.

5. Remove the batteries from the sonde.

6. Remove the restrictor from the sonde body.

7. Remove the blue end cap from the restrictor.

8. Screw the blue end cap on to the restrictor end opposite of the flow-through holes.

9. Screw the restrictor on to the sonde.

10. Place a dust cap on the sensor connector.

11. Store the sonde and pH/ORP sensor in the box they arrived, at temperatures
between -5° to 65° C.

Cleaning the Sonde
Rinse the sonde thoroughly, clean with warm water and mild soap, then rinse the sonde
again. Allow to air dry.

Prevent water from entering the cable connector.

Cleaning and Storing the pH/ORP Sensor

Routine Maintenance

If the ORP platinum electrode is dull or dirty, it can be cleaned with a swab and
methanol or isopropyl alcohol. Rub the electrode gently until it is shiny.

The pH sensor must be kept moist for the life of the sensor.

The sensor fill solution has a shelf life of 2 years. Replace the fill solution every 5 to 6
months or when:

l The sensor fails to calibrate within the acceptable slope and offset range.

l Sensor readings vary.

l Readings during calibration at pH 7 are greater than +30 mV or less than -30 mV.

l Sensor is slow to respond.

If the sensor fails to calibrate after you replace the fill solution,
replace the reference junction.
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Replacing the Filling Solution

1. Remove the sensor from the port.

l TROLL 9500—Use the sensor removal tool to pry the sensor up and out of the
instrument.

l Aqua TROLL 400—Grasp the sensor by the finger grip and pull out of the
instrument.

l Aqua TROLL 600—Loosen the screw at the bottom of the sensor. Insert the
tool into the small hole and lever the sensor out of the sonde.

2. Install the dust cap on the connector end or wrap the connector end in a paper towel
to prevent solution from entering the connector.

3. Unscrew the reference junction.

4. Hold the sensor at an angle and shake out the old filling solution.

5. Using the dispenser cap on the filling solution bottle, insert the tube into the bottom
of the empty reservoir. Squeeze a steady stream of solution into the reservoir until it
overflows and no bubbles are observed. Continue to add solution while pulling the
tube out of the reservoir.

6. Attach the reference junction to the sensor and hand-tighten until firmly attached.
Some filling solution will overflow. Wipe the excess off the sensor body.

7. Soak the sensor in tap water for at least 15 minutes.

8. Calibrate the sensor.

If necessary, thoroughly clean the sensor connector to remove
filling solution: Using a disposable pipette, fill the connector with
isopropyl alcohol (70% to 100%), Shake to dry. Repeat 3 times.
Dry overnight. When thoroughly dry, calibrate the sensor.

Replacing the Junction

Replace the junction when the sensor fails to calibrate with a reasonable slope and
offset, even after you have replaced the filling solution.

1. Unscrew the reference junction and discard.

2. Replace the filling solution and screw in a new reference solution.

3. Soak for 15 minutes, then calibrate the sensor.

Keep the junction damp at all times to avoid a lengthy rewetting
process.
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Cleaning

Begin with the most gentle cleaning method and continue to the other methods only if
necessary. Do not directly wipe the glass bulb.

To clean the pH sensor, gently rinse with cold water. If further cleaning is required,
consider the nature of the debris.

To remove crystalline deposits:

l Clean the sensor with warm water and mild soap.

l Soak the sensor in 5% HCl solution for 10 to 30 minutes.

l If deposits persist, alternate soaking in 5% HCl and 5% NaOH solutions.

To remove oily or greasy residue:

l Clean the sensor with warm water and mild soap.

l Methanol or isopropyl alcohol may be used for short soaking periods, up to 1 hour.

l Do not soak the sensor in strong solvents, such as chlorinated solvents, ethers, or
ketones, such as acetone.

To remove protein-like material, or slimy film:

l Clean the sensor with warm water and mild soap.

l Soak the sensor in 0.1 M HCl solution for 10 minutes and then rinse with
deionized water.

After performing any of these cleaning methods, rinse the sensor with water, then soak
overnight in pH 4 buffer.

Short-term Storage

Up to 1 week: Fill the electrode storage bottle with pH 4 buffer and immerse the sensor
tip in the buffer. Tighten the cap to prevent drying. Alternatively, pH 7 buffer can be used
for a few days.Soak the sponge included with the black storage cap with pH 4 buffer
and install the cap on to the sensor. Use electrical tape to seal the cap onto the sensor
to prevent leaks or the sponge drying out.
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Long-term Storage

Greater than 1 week: Fill the electrode storage bottle with 10-20 mL of storage solution
(0065370) and immerse the sensor. Tighten the cap to prevent drying.Soak the sponge
included with the black storage cap with storage solution (0065370) and install the cap
on to the sensor. Use electrical tape to seal the cap onto the sensor to prevent leaks or
the sponge drying out.

Storage Recommendations

Prior to using the pH sensor after long-term storage, rinse the sensor with DI water and
then soak it in pH 4 buffer for 1 or 2 hours. This will saturate the glass bulb with
hydrogen ions and prepare it for use.

Do not store the pH sensor in DI water because it will deplete the
reference solution and drastically reduce the life of the sensor.

Cleaning and Storing the RDO Sensor

Routine Maintenance

1. Leave the sensor cap on.

2. Rinse the sensor with clean water.

3. Gently wipe with a soft cloth or brush if biofouling is present.

4. If extensive fouling or mineral buildup is present, soak the sensor in vinegar for 15
minutes, then soak in deionized water for 15 minutes.

Do not use organic solvents—they will damage the sensor cap.
Do not remove the sensor cap when rinsing or brushing.

5. After cleaning the sensor, perform a 2-point calibration.

Cleaning the Optical Window

Clean the optical window only when changing the sensor cap.

1. Remove the cap.

2. Gently wipe the sensing window with the supplied lens cloth.

Do not wet the lens with any liquid.

Storage

Prior to installation, store the sensor body and cap in the factory supplied containers.

Once installed on the sonde, the RDO sensor can be stored wet or dry depending on
the sensor configuration of the sonde.
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Never store the RDO sensor without the sensor cap once it has
been installed on the sonde.

Cleaning and Storing the Conductivity Sensor

Cleaning

Begin with the most gentle cleaning method and continue to the other methods only if
necessary.

To clean the conductivity sensor face, gently rinse with clean, cold water. If further
cleaning is required, consider the nature of the debris.

To remove crystalline deposits:

l Clean the sensor face with warm water and mild soap.

l Use a soft brush to gently clean the sensor pins and temperature button. Ensure
removal of all debris around the base of the pins and button.

l If crystalline deposits persist, soak in 5% HCl for 10 to 30 minutes followed by
warm soapy water and soft brushing.

l If deposits persist, alternate soaking in 5% HCl and 5% NaOH solutions followed
by warm soapy water and soft brushing.

To remove oily or greasy residue:

l Clean the sensor face with warm water and mild soap.

l Using a soft brush, gently clean the sensor pins and temperature button. Ensure
removal of all residue around the base of the pins and temperature button.

l Isopropyl alcohol may be used for short soaking periods, up to one hour.

l Do not soak in strong solvents such as chlorinated solvents, ethers or ketones
(such as acetone).

To remove protein-like material, or slimy film:

l Clean the sensor face with warm water and mild soap.

l Using a soft brush, gently clean the sensor pins and temperature button. Ensure
removal of all material/film around the base of the pins and temperature button.

l Soak the sensor in 0.10% HCl for 10 minutes and then rinse thoroughly with
distilled water.

Storage

Prior to installation, store the sensor in the factory supplied container.

Once installed on the sonde, the conductivity sensor can be stored wet or dry
depending on the sensor configuration of the sonde.
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Cleaning and Storing the Turbidity Sensor

Routine Maintenance

The optical windows should be clear of foreign material. To clear material gently rub the
sensing windows using clean water and a soft cloth or swab. Do not use solvents on
the sensor.

Storage

Prior to installation, store the sensor in the factory supplied container.

Once installed on the sonde, the turbidity sensor can be stored wet or dry depending on
the sensor configuration of the sonde.

Replacing Wiper Bristles
Wiper bristles need to be replaced based on site conditions. In-Situ recommends
replacing bristles at least every 12 months or when visibly bent, damaged, or fouled.

Replace the Bristles

1. Loosen the set screw near the base of the wiper head.

2. Slide the wiper head off the wiper shaft.

3. Slide both bristle sets out of the wiper head.

4. Insert new small bristle set into the small slot and the large bristle set in the large
slot.

5. Slide the wipe head on to the wiper shaft, and position the wiper head so the set
screw faces the flat part of the wiper shaft.

6. Tighten the set screw near the base of the wiper head.

Replace the Entire Brush

1. Loosen the set screw near the base of the wiper head.

2. Slide the wiper head off the wiper shaft.
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3. Slide the wipe head on to the wiper shaft, and position the wiper head so the set
screw faces the flat part of the wiper shaft.

4. Tighten the set screw near the base of the wiper head.

Cleaning the Copper Antifouling Restrictor
When copper is deployed in environmental waters, particularly marine environments,
the copper will oxidize and its biocidal properties decrease. Cleaning the copper
restores the effectiveness of the restrictor's antifouling capability.

1. Remove the restrictor from the sonde.

2. Remove the restrictor end cap.

3. Submerge the restrictor in white vinegar (acetic acid) for 24 hours.

4. Rinse the restrictor in water and air dry.
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Declaration of Conformity
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